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Please read user manual before using the device.
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1. Technical data and requirements

REVELPROG-IS made by REVELTRONICS is a professional tool for serial memory programming. It supports wide range of EEPROM, FLASH and
FRAM devices with I2C, SPI, 1-wire and uWire protocols powered with 1.0V - 5.0V voltage levels. It has integrated ZIF socket (for THT devices)
and SOIC socket (for SMD devices). It has also connector for in-circuit serial programming (ICSP) with buffered I/O. Due to USB 2.0 interface

memory operations are really fast.

Technical data:

e power supply and communication via USB 2.0 (hardware level, bulk transfer),

e supported protocols: I12C, SPI, 1-WIRE, MICROWIRE,

e supported devices with 1.0V - 5.0V power supply,

e programming device powered from programmer (1.0 - 5.0V, Imax = 100mA) or from external circuit (1.0 - 5.5V),
e operation speed (read/write) up to 10Mbit/s,

e ZIF-32 + SOIC-8 (150mil) integrated sockets,

e connector for in-circuit serial programming (ICSP) with buffered 1/0,

e auto adaptive I/0 pins connected only for programming time (Hi-Z in IDLE state),

e short circuit and overload protection,

» device manufactured in EU, made in Poland.

Requirements:

e USB 2.0 or above,
+ Windows XP, Vista, 7, 8 or 10 (32 and 64 bit) + .NET Framework 4! installed in OS.

1 NET 4.0 Client Profile can be downloaded from MICROSOFT: http://www.microsoft.com/en-us/download/details.aspx?id=17718
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2. Features and applications

REVELPROG-IS is used in many applications such as: car electronics & automotive (reprogramming modules, radio-code, mileage correction,
immobilizers, gps navigations), computer service (data recovery, reflashing/upgrading/programming BIOS chips on motherboards of PC, notebooks,
copier & fax machines, printers, SFP/QSFP/XFP transceivers etc.), RTV/AGD service (TV & TV tuners, digital cameras, multifunction devices etc.) and
many other devices equipped with serial I2C/SPI/MICROWIRE EEPROM and FLASH chips. Due to the possibility of change voltage level (in range of 1.0
- 5.0V) programmer supports both older and newer devices (e.g. latest devices equipped with 1.2V and 1.8V low-voltage chips). Device is equipped
with ICSP connector that allows in-circuit serial programming without unsoldering the chip from board - built in additional protection (buffered

I/0, short circuit and overload protection) increase reliability and safety of such operations.

Main features:

e reading / writing / erasing functions with user-friendly application interface,

e supported binary files (*.bin, *.rom, *.epp etc.) and Intel-Hex (*.hex) with possibility to load file to the buffer, edit it, calculate checksums,
swap-bytes, save modified bytes as patterns, compare with chip etc.,

e programming in socket or in external circuit (without unsoldering the chip),

« the target application device can be either powered by REVELPROG (possibility to change VPP and logic levels: 1.0V / 1.5V / 1.8V / 2.5V /
2.8V / 3.3V / 5.0V) or powered by an application with external power supply (1.0 - 5.5V),

e build in additional protection: buffered I/O pins internal connected only during programming + short circuit and overload protection (reduces
the risk of damaging parts due to connection mistake),

e integrated sockets (ZIF + SOIC) with auto adaptive I/O pins reduces requirement of additional adapters,

+ short programming time?, e.g. WINBOND W25Q80BV (8Mb): read 0.9s (8,4Mb/s), write 3.3s (2,4Mb/s), MICRON N25Q128A (128Mb): read
12.8s (10Mb/s), write 37.6s (3,4Mb/s),

« useful tools such as: save/load patterns with changes, i2c/spi custom scripts, auto backups, file comparing etc.

2 Due to USB 2.0 hardware layer (BULK mode) maximum real transfer is up to 10Mbit/s for read/write operations but in many cases transfer is limited by read/write time cycle from/to
memory (e.g. write is always slower than read). Write time does not include chip erase time (you can find tCE in device datasheet) and verification (read) time. There is possibility to change
write sequence (e.g. without erasing and verifying) but most devices require at least chip erase before write operation.
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3. Installation of software and USB drivers

Requirements:

PC application is compatible with MS Windows3 XP, Vista, 7 , 8 and 10 (32 and 64-bit versions). You will need also .NET Framework 4.0 to run
application (probably already installed* in your OS)

Software installation:

Software installation is typical for Windows. Just run setup (REVELPROG-IS_v1-x_Setup) and follow instructions (next, next, finish;). You may be

prompted for USB driver installation (accept it). Shortcut to REVELPROG-IS app will be added to the desktop. Application is ready to run.

Drivers installation:

In most cases drivers will be successful installed during application installation. Drivers may be installed also later from application (menu "help" ->

"install drivers").

Windows XP users will have to install drivers after first device plugged-in - just select drivers location in installation folder (by default it is
"C:\Program Files\REVELTRONICS\REVELPROG-IS\drivers\REVELPROG-IS"). If you miss it, you can install drivers later manually (run device manager,
find "REVLPROG-IS" device on the list, right click and update driver, select driver location).

Windows 8/10 x64 users will have to install drivers from REVELPROG-IS application by using "Zadig" installer (menu "help" -> "install drivers with
Zadig"). You should select REVELPROG-IS device on the list and install WinUSB driver, video: https://www.youtube.com/watch?v=6AFD3yBsRNc

3 Windows XP with SP3 installed (service pack 3). Windows 7 with SP1 installed.
In case of "fresh" install of OS you may need also "Microsoft Visual C++ 2010 Redistributable Package" (http://www.microsoft.com/en-us/download/details.aspx?id=5555)

4 if NOT, you can download and install it directly from Microsoft web page: http://www.microsoft.com/en-us/download/details.aspx?id=17718
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4. First steps with REVELPROG-IS application

4.1. User interface

Application interface is user-friendly. All main functions can be run directly from shortcut icons (all icons are actived after device connected). Please

move cursor above specific icon to see additional tooltip.

r
B Revelprog IS (v1.3) l-:l:l. =
File Edit View Settings Help
%, % s, % 8 . . 4 o, :
% L, o "an‘ % s g {g&% % )
& =f;.¢ % S ':’a@ N ﬂ’&, %, e &,
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- % ® % = 2 0, s
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-~ e (-
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4 g %%,
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) e Ve %
- 8. %,
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Programator podiaczony (v1.3.0) CRE3Z .c




Memory buffer is displayed in hexadecimal + ASCII format. There is possibility to edit buffer as bytes and as ASCII characters.

Additional information is displayed in lower area: r. Revelprog IS (v1.3) = |

File Edit View Settings Help

® & Q0

C3 FC 4C ED 05 &8F 71 27 16 CE 7C F5 OFRaLi..g Y. |8 «
4B 93 BE OE FD BC 27 11 25 45 4C &A 21 E& IVE.%. 748 . 3ELy*a |
28 92 03 D9 25 71 B7 8C F2 10 3B C7 96 94 M L
24 C6 45 95 49 C7 AF 99 07 BB &6 70 59 9B UisEE.I¢ ..«fpY.
€O 85 DC 78 EC &8 6A 38 OF €2 F7 36 70 BF M.A.Uxihje.&s6):
29 15 41 5D B7 BB 7E 16 16 ED B3 E5 E& 17 APE.R] r»~..1%82.
27 B3 FE &D EAL 1R 2E 3C Fa DF E3 F2 C39 49 i.' pmé..<aBRE0ET
EB D4 9B D4 C& FA 58 C2 DB 97 4D 2B 18 &9 ...0.0EaXAT . M+. @
A0 4D 94 &F OF 22 69 7D 8C 8E 1B 68 F5 72 IW M.o."il...h8=z
1D 87 41 7B &0 D9 48 AE 03 E9 D2 39 1E 12 ik..n{ UH®.200..

» buffer information: buffer size in bytes,

buffer addresses range and current

address (or addresses range) of cursor

position (selection) with calculated

=

checksum-16 (from selected bytes),

« status bar (programmer version info or

last operation info),

11 AF CD 48 B3 11 49 B5 C5 A9 3E 97 61 OF .%. 1H®.Ipke>.a.

57 E4 22 E6 C6 RO 1B BD SE D7 63 96 09 88  .AWA"=E .M xc...

e CRC-32 checksum calculated from buffer 03 9 DC D7 8F &8 BC 71 C8 BC 70 13 4F 38 .C.ilx .h%gElp.08
. . D5 D4 35 BE A3 8D 63 A7 E1 08 A8 63 CD B5  !5005% .c8a. cin

or opened file (click on "CRC32" to A4 40 F8 OF C2 9F 75 12 DA 09 SA 04 ES 99 . Iu@e.A.u.0.Z.&.

recalculate checksum) b6 &8 WE G0 k5 DY W4 F5 BS DA €4 4F 94 BY C20xgA . NLo¥REQD -

€6 2D 5€ F7 €CE 21 EC CE 67 87 26 26 35 49 }.E—'}.;i'.iig.&&EI
3E 22 D4 BD 32 91 68 09 E7 56 76 A2 2C 20 Gar»"0%..h.cVve,
ZE ZE 40 ZE ZE ZE XE ZE ZE 4B ZE ZE ZE ZXE T e  ——
77 2E 52 45 ‘56 45 4€ 54 52 4F 4F 49 43 ‘53 wiww . REVELTRONICS
1 6% 60 2E IR -2EJE-IF-IPCIECDECIFIFIFEDFE iLole e e e T
F-ZE 52 45 56 45 4C 58 52 4F 47 2D 49 53 ZK ELPROG-IS.
g 2E JE JE JE 20 2E JE ZE JE JE %0 2XE JE H5 5
[a] Xaks) } ns w0 = o T A n L TN neg A2 For] A A A0 A2 == ot "] o ]
Address; 0130 - 0x15F (45 bytes, checksum-16: 00 CFF)
Buffer size:  0xD - 0:3FB {1020 Bytes)
Programmer is connected (v1.3.0) CRC32: 0x2C5C0062 .:
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4.2. Device programming

Device type should be selected from the device database before any operation ("chip select" icon). Voltage will be set automatically. It can be
changed manually by clicking VPP icon. In case of ICSP programming with external power supply, VPP should be set to the same level as memory

power supply.

B Revelprog IS (v1.3) = | = 22

4.2.1. Reading

File Edit View Setbings Help

' - \ = .
Before device reading operation, memory type should be - - s _”_"ﬂ £ m W

chosen. Please check also VPP voltage (you may need to

change it in case of low-voltage chips). Click READ icon

L
6B [ B
LI I

(memory chip with green arrow).

Programmer will read device. Memory content will be loaded

into the buffer. Buffer can be saved to external file. You can llllllllllllllllllllllllll_ .T'_'f

also edit the buffer and reprogram the device.

Please note at the CRC32 checksum (right corner at the
bottom). If checksum is equal after each read than the risk of

read with error usually does not exist. It is a good practice to

make memory backup to external file before any writing.

[ 8 o I B e I Y o |

ST
|

The reading may be incorrect due to communication error or annAnTon €€ nE Be ne wn wE a3 on o ns o £n en o 33 5o o

broken chip.

Reading ... (9029.4 kb/s) CRC32: (WB91BAGED ::

b .
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4.2.2. Writing

Before device programming operation, (1) memory type should be chosen and (2) buffer should be filled with data. You can load data from external
binary (*bin, *.rom, *.epp etc.) or Intel-Hex (*.hex) file. Please check also VPP voltage - it may be changed in case of low-voltage chips. Please click

“WRITE” icon (memory chip with red-orange floppy disk).

B Revelprog IS (v1.3) = B X |

Programmer will erase the device, write data to memory from
Filee. Edit View Settings Help

the buffer and make verification process. There is possibility to

change writing sequence from menu: Settings -> Write

sequence. Verification process will read the device after writing
and compare reading with the buffer. If verification pass than
memory is successful programmer. Verification error may occur

due to communication error, secured or broken chip.

4.2.3. Erasing

D W e

Programming... {2446.7 kb/s) Cancel

To erase memory, empty buffer can be loaded and

programmed into a memory. In most cases this operation is not

SR o R e B

I IRV = L I 0 B R I
I
I
I
I
I
I

necessary, because programmer supports fast erase procedures
(Page Erase, Block Erase and Chip Erase). Please click "ERASE"”

(O I R

b
I
b
I
b
I
b
I
b
I
(AT S P R R )
010
b
I
b
I

1
L L)

icon (memory chip with OxFF and broom) for erasing operation.

b
I
b
o R
b
I
b

1 Bub Bd B3 B s B LA Fi]
o B o4}

1
i
1
3]
N o R 8 I
4
]
1
]

Please note that erasing progress is not displayed at progress ::..::.:"' = == ne 22 s 02 o na sn sn Fe a2 20 ac 2a  mAR . afashiane

bar. For high density FLASH memories erase process may took

quite long (even few minutes!). Programming... (24407 kb/<) CRC32: :A91BASES. .

LN A
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4.3. HEX editor features (buffer editing)

4.3.1. HEX editor

File Edit View Settings Help
Buffer can be edited from application level. In e E—E——- ce—
the first column there is current address
displayed. In the second column there is memory P
contents displayed (as bytes in hexadecimal

mode). In the third column there is ASCII

01

representation of memory contents. All buffer
operations are allowed (e.g. CTRL+C, CTRL+V

0060
etc.). Modified buffer can be saved to external 0070
. . 0000080 ) General | Hardware | Apperance |
.bin or .hex file. 300090 |\ y o '
000000A0 Buffer ([Hex Editor)
Colars
General Selected area
) Background: [ N NN Background: [ |
4.3.2. Appearance 00 Font: [ | Font: [N

Header: |:| Edited area
There is possibility to personalize hex editor, —

e.g. color and font changes. Bigger font and dark Font:

contrast colors will enhance your work with editor Courier Mew, 11.25 | Change |

especially on high resolution displays.

Address: 030 - 0x6F {64 bytes, checksum-16; (x2EBES)

Load template

Th« .Th« .

Light

Light [enlarged)

Dark (enlarged]

|

Cancel

Buffer size:  0x0 - DxFF (256 Bytes) WiWork'idumps'\83c56\scenic,bin®

Programmer is connected (v1.5.0)
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4.3.3. Fill buffer...

Fill selected bytes with constant bytes or defined pattern.

1. Open context menu (right click) and choose fill...

00 01 02 0. 08 09 0a OB
90 22 02 00 6D
54 FE aB 01 54
s 4 Cut

oc 0E

00000000
00000010
09 00
EE EF

00000040 FF FF Cop}r
00000050 FF FF g} B
100060

FF FF Fill...
FF FF —
00 05
01 00
FF FF
BS EE

00000070
Load changes from pattern...

00000080

1000090
000A0

00000080

Save changes as pattern...

Select all

00 01 O 03 04 05 06 07 08B 09 On OB 0OC OD OE

22 02 00 6D DD 90 22 02 00 6D DD 90 22

DD 50 22 02
00000030
00000040
ax00 @ Pattern

000000 @ Selection

%

3. Take profit - you have just saved some time...

Settings  Help

04 05

006000020
00000030
00000040

00000060
00000070

000000R0
00000080
000000C0

000000E0
000000F0

Address: D18

Buffer size:  0x0 - OxFF [256 Bytes)

0B

01
FF
FE
FF
FF
PE
FF
7%

FF

oc

54
FF
FF
17
FF
EP:
FF

0D

FE
FF
FF

FF
FF
FF
3D
FF
FF
FF

02
FF
FF

VYVVVVVVVVVYVVVY
VVVVVVVyyyyvyyyy

WiWorkhdumps'\@3¢56'scenic bin®

Programmer is connected (v1.5.0)
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4.3.4. Patterns - export changes to file

All manual changes (highlighted bytes) can be exported to external file (pattern). Later, at any moment there is possibility to load pattern file and all

changes will be imported, without modifying other bytes in the buffer. Simple, fast and powerful.

00 01 02 03 04 05 06 07 08 09 Op OB OC 0D OE OF

5
Fi

Fill...

Load changes from pattern..,

Sa\re changes as pattern...

Select all

000000D0 8z 00 00 35 01 53
0000 l'H'IE 0 FF FF FF FF FF
EE: EX-EE FE EE YYYYYYYYYYYYVYVY

4.3.5. Swap bytes

Swap bytes operation will change byte order in 2-bytes word. For example, swapped word OXABCD will be equal to OXCDAB. This functionality is very
useful for memories with two addressing modes, e.g. for microwire 93... series 16-bit chips. REVELPROG supports both addressing modes (8-bit and 16-

bit) for these devices.

File Edit View Settings Help File Edit View Settings Help

wlH ' S |k &% v -

53_06 {160it)

H: 01 &7

0G0 03104 S a7 : il : ; i 7, # -—. ~r .-.. -. -. _ o .- = o S..\_.a Byte
01 23 45 €7 29 RB CD EF 01 23 45 &7 2% AB CD EF  .#Eg.«fi.#Eg.«ll B0 €1 a5 dn A9 BROCH B g1 69 45 e A9 BRD.  BiEEe T ke lII i
01 23 45 &7 29 AR CD EF 01 23 45 &7 25 AR CD EF .#Eg.«ii.#ig.«ii 23 01 67 45 AB 89 EF CD 23 01 &7 45 &B B9 EF CD #.0E«. ifz. gE«. if
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4.3.6. Clear buffer or generate random buffer

There is possibility to clear buffer (OxFF) or generate random buffer from Edit menu. Buffer length will be equal to memory size. CTRL + N shortcut

will clear buffer and CTRL + N shortcut will generate random buffer.

4.3.7. CRC32 and Checksum-16

Click "CRC32" in right-bottom corner to calculate CRC32 checksum from the buffer. Changing single byte in the buffer will change CRC32 checksum
so this feature is useful in comparison of sequential reads or files. Checksum-16 is calculated in real time from selected bytes in the buffer area and it's
displayed in buffer info. This is most common algorithm for checksum used in wide range of devices (checksum of mileage, operation hours, serial

numbers etc.) To calculate Checksum-16 from all addresses select all bytes in the buffer area (CTRL+A).

File Edit View Settings Help

ﬁiﬁ}»v ﬂﬁpF} . | OxFF WETA B .&ﬁ}_
01 02 03 04 05 06 07 08 09 OaA OB OC OD OE OF -
50 CF EC BB 54 B7 7B 50 42 29 11 0OF OF Aa 3D pPIi»T-{PB)...3= [
4B 86 B7 AE B6 cD .K..®.BD".a.~¥I;

(. T¥&coa:a¥*% 1n
sp..*t] ... <{HO¥lx
t.en®I. 'T{MEAS. .

2L E.5vwA%D.3Q06.

F9 E9 34 BT 7B E9 éued-{&}. B.d4d.M)

20 FO 365 07 32 Ao 3F 11 71 30 95 Fc 7B F4 03 L 115.2.2. 00,1018, T
Address: | 0x20 - Dx5F (B4 bytes, checksum-16: 0x223F)

Buffer size:  Owd - 0x7FF [2 KB)

| Programmer is not connected. CRC32: 0xD3D48FDF |.:

4.3.8. File format conversion: .bin <-> .hex

I Application can be used also as a simple file converter (binary to intel-hex and vice versa). To convert file from one type to another, just open file

(load to buffer) and save it in another format.
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4.3.9. DiffChecker (file comparing)

DiffChecker tool allows to compare 2 bin or hex files. All differences will be selected and grouped. Press F3/F2 to find next/previous difference region.
You can save all differences to external file as a pattern (feature described in Chapter 4.3.4). If files are totally different then first 1000 different
regions are marked.

EF DiffChecker — O b
TI" Wi Worlddumpsi93c58iscenicl.bin 2588 ((xAd42E)
00 01 02 03 04 05 06 07 08 09 OR OB OC 0D 0OE OF A
00000000 9 9p 22 00 m{, ", . m¥, ", . mf, "
00000010 54 FE AB 01 54 FE RB 01 LLIE " Th«.Tb«.
00000020 0% 00 FF FF FF FF FF FF FF FF FF FF FF FF FF FF . VYV VYYYYE
00000030 FF OFF FF FF FF FF 0% 00 FF FF FF FF FF FF FF FF §999VY. . VHVTT00T
0o0o00o4n  FF FF FF FF FF FF FF FF FF FF FF FF [WLFF FF

00050 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
00000060 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF  §yUidvodyvodvosy
0ooooo7o FF FF FF FF FF FF FF FF FF FF FF FF FF FF D9 3D §9vddvodyvsdvel=

00000080 00 05 0L 00 01 00 1E 18 00 3B 06 6R DS 3D 00 05  weewenen. ;.30=..
0o 01 00 01 00 1E 18 00 3B 06 &R 03 00 FF FF FF FF ..u.... Pod. . FEET
000000R0  FF FF FF FF 03 00 FF FF FF FF FF FF FF FF 1B 1R GUUT. . FUTTETVE. .
0000000 BS EE 13 00 06 57 29 56 pi...W)...BE..§.V
opoooooco 46 31 4R 4D 30 47 44 EEEEEEEENEEEEEEEEYEEEN:1 2 F1JMoGD6E35095491
00000000 35 19 82 00 00 05 01 45 00 00 35 01 53 02 FF FF  5...... F..5.5.0%
000000ED  FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF  §U§0Fdodoodoivd
000000F0  FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF U900 0d0idoiviv v
?,v WiWorld dumpsi93c56iscenic2.bin 2568 (ATOB) .:
00 01 02 03 04 05 06 07 08 09 -334- 0B 0C 0D OE OF ~
00000 a2 lz¥.3.1z¥.3.1=7.

00010 AR 01 54 AR 01 3.12z%.3.The«.Th«.
0onzo 08 00 FF FF FF FF FF FF FF FF FF FF FF FF FF FF ..V 9vovvovvivey
0nn20  FF FF FF FF FF FF 0% 00 FF FF FF FF FF FF  §VU§yV.. ivivvy
00040 FF FF FF FF FF FF FF FF FF FF FF FF ERMLENFF FF G0 Fd0od9oivLICTy
\00nsc  FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF  §yVodioivvovivy
oooec  FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF G0 Td0oi9oivvoey
00070  FF FF FF FF FF FF FF FF FF FF FF FF FF FF D9 3D YT EVEEU=

00 05 01 00 01 00 1E 18 00 3B 06 6B DS 3D 00 05 wuvenewn. ;.i0=..
01 00 01 00 1E 18 00 3B 06 62 03 00 FF FF FF FF  wuvun.. Ped. . TEET
FF FF FF FF 03 00 FF FF FF FF FF FF FF FF 1B 13 yyyy..yyyyyyyy..
i B5 EE 13 00 06 57 29 56  pi...W)...E..3.V
000000CO 46 31 4B 4D 30 47 44 [PEETIEEEETEEEEETEEERETN:1 Fi1oMocD243252341
000000D0 35 19 82 00 00 05 01 45 g0 00 35 01 53 02 FF FF F..5.5.%%

000ED FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FYVIFyyy
000FD FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FYYyVVVivyvyvvyy v
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4.4. Additional features

4.4.1. Blank test

Blank test checks if chip is empty. Test will be canceled as soon as first programmed cells will be detected (there is no need to read full memory).

4.4.2. Compare with the buffer

Operation compares buffer with the contents of memory. Operation will be cancelled as soon as first difference will be detected.

4.4.3. VPP selection

VPP is set for both: programming voltage and signal levels. VPP can be changed with 0.1V step in range of 1.0 - 5.0 volts. This feature is very useful

in few cases:

e in order to program low-voltage variant of the device (e.g. 1.8V instead of 3.3V),

e in case of in-circuit programming with external power supply -> programmer voltage should be the same as external circuit voltage or VPP
should disabled (VPP OFF),

e in case of in-circuit programming without external power supply. In many cases there is no need to set nominal voltage for external board. For
example: memory operates in range of 2.6 to 3.6 volts. Nominal voltage for external board is 3.3V. Setting the lowest operational voltage (2.6V)
will be enough to power and communicate with the memory and at the same time will be too low to power all circuits around. First of all, if there
is main microprocessor on the board than it will not communicate with the external memory (because it will be in "reset" state due to low
voltage to operate) so it will be possible to communicate with this memory using external programmer. Secondly, you will save current
consumption because devices in reset state consume much less power. This trick is not always possible, so if you can't communicate with the
device in external circuit try to plug-in external power supply or unsolder the chip and program it in socket. Please read Chapter 5 for more

details.
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4.4.4. Device identification (Chip ID) for FLASH SPI, DATAFLASH and 1-wire devices

In order to read Chip ID please select “Tools” -> “Read ID”. Operator should know operating voltage for the device because REVELPROG-IS supports
also low voltage chips and reading chip ID without knowledge about chip power supply level is risky (setting 3,3V for 1,8V chip will damage it even
during chip id reading). For FLASH devices programmer will read 4 identification bytes of data (JEDEC ID)- 1t byte is Manufacturer ID, 2"¢ and 3™
bytes are Device ID and 4™ byte is Extended ID. You can read about identification bytes in device datasheet. For 1-wire devices programmer will read

64-bit unique identification number.

4.4.5. Quad SPI (QSPI) configuration for FLASH SPI

Some of FLASH SPI devices may require to enable QSPI mode before soldering it in external device. This will require to change one of configuration

or status registers in device memory map.
TIP: in most cases, specially when you reprogram FLASH SPI there is not necessary to change any configuration bits.

To enable or disable Quad mode you can use dedicated tool (Tools -> Quad SPI) - it will work with most popular FLASH SPI devices (e.g. Winbond
and Spansion). For other devices it may be necessary to write custom script (with Custom Script tool - described in Chapter 6) to enable or disable

QSPI mode manually by changing QSPI bits in required registers. You can read how to change Quad SPI mode for your device in device datasheet.

4.4.6. SFP/QSFP/XFP Transceivers support

REVELPROG-IS has dedicated tools for optical transceiver support. There is SFP/QSFP/XFP adapter required with external power supply. MSA
Standard is supported (e.g. SFF-8472, SFF-8636, INF-8077i). Dedicated functions allows to enter manufacturer/host password and program write
protected transceivers, brute force password (searching password for protected transceivers with unknown password), change manufacturer info,

model, serial number etc. and recalculate checksums directly from REVELPROG-IS application. Please check Chapter 7 for more details.

4.4.7. Auto backup

Every read operation there is backup file (.bin) generated (by default it is user documents folder in system). By default maximum 16 files are
created (oldest are deleted) and size is limited to 8Mbit devices. You can change these parameters in Settings -> Option -> File -> Autobackup (you
can set unlimited number of files and size).
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5. In-Circuit Serial Programming (ICSP)
Caution! Before ICSP programming please read following instructions!

ICSP programming is recommended only for advanced users. There is required technical knowledge and being familiar with specific chip. You should

read carefully device datasheet, especially memory pinout, addressing modes and voltage levels.

Programmer is equipped with 10-pin ICSP socket (IDC10). There’s only 8 pins used (pin-9 and pin-10 are not internally connected). Pinout

numeration (1-8) is the same as memory pinout in datasheet for DIL8/S08 package.

There will be various signals at these pins during chip programming (digital and analog signals). These signals are assigned automatically after

memory chosen (in application) and are set only during memory operation.

5.1. Addressing in external circuit

All hardware addressing outputs for EEPROM 24.. series (pin 1,2,3 ie A0, A1, A2) must have low voltage level (GND). If chip in circuit is addressed in

other way (e.g. there are few the same chips, which require various addressing) then communication will fail. In this case you can (1) set correct
addressing in application (“External addressing” option during memory selection) or (2) set default “"0” addressing with the programmer (connect

addressing wires to the chip and in the same time disconnect them in external circuit) .The safest option is to unsolder the chip and put it to integrated

programmer socket.

Addressing 8/16-bit for EEPROM 93 series also needs special care. In circuit addressing wire (pin 6) can be connected to low or high state (it's
defining addressing mode if memory support both modes). Depends on your chip selection in application (8/16 bit) programmer gives LOW or HIGH
state on this pin. If you choose wrong addressing (e.g. in circuit it is low state and programmer outputs high state) than you will make short circuit. In
most cases it's not necessary to connect addressing wire (pin 6) for microwire 93 series - it's enough to select right mode from application (16-bit in

most cases).

If you are not 100% sure about connections, DO NOT program in circuit - unsolder the chip and program it with integrated socket.
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5.2. Write protection in circuit (WP/PRE pin)

A lot of serial devices have WP (Write Protect) or PRE (Protection Enable) input. Low state on this pin (ground) protect the device from erasing and
writing. Programmer outputs a high state during erase or write operation. If in external circuit write protect pin is connected to ground (common case),
and programmer will output high state on this pin, than it will lead to short circuit. There are 3 common solutions in this case: (1) do not connect write
protect pin (erase/write will not work), (2) disconnect write protect pin in circuit (connect it only to programmer) or (3) unsolder the chip and

programm it in programmer's socket.

WP (Write-Protect) or PRE (Protection Enable) pin can be found e.g. in FLASH SPI 25.. (pin 3), FLASH SPI 26... (pin 3), FLASH SPI 45... (pin 5),
EEPROM I2C 24... (pin 7), EEPROM SPI 25.. (pin 3), EEPROM SPI 35... (pin 3), EEPROM SPI 95... (pin 3), EEPROM MICROWIRE 93... (pin 7).

5.3. Power supply in external circuit

The target application device can be either powered by programmer [voltage level (VPP) can be chosen from: 1.0V - 5.0V - please read Chapter
4.4.3] or powered by an application within a voltage range of 1.0V to 5.5V. If chip is already powered in external circuit, than VPP should be set to the
same voltage as external power supply (0,1V accuracy is tolerated). Absolute maximum rating at programmer's I/O pins is 5.5V - exceed this value

may damage protection buffers in programmer.
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5.4. Limits and possible issues during in-circuit programming

In some cases there is no possibility to program chip in application. This can be due by many reasons, such as:,

+ to long signal wires,

+ too much load capacity in circuit,

« incorrect pull-ups or pull-downs on signal wires,

+ incorrect addressing,

« bus conflict (memory is during communication with other device),
+ impedance not match,

« additional capacitors, diodes bus-switches etc. in circuit.

In case of power supply from programmer, current is limited to 100mA for
safety reason. If application requires more power, than external power

supply should be connected.

In case of incorrect connections, short circuit or overload, following error
(pict.) will be displayed and all I/O will be disconnected. Delay of protection
trigger is 5-35ms so you still have to be careful. Programmer implements
"VPP-boost" mode which allows for 3x higher current consumption at the
first 30ms of operation (e.g. for capacitor charging). There is also possibility

to increase in settings overload protection to 200mA.

If you are not sure about connections or voltage levels DO NOT
program in-circuit. It is much safer to unsolder the chip and

program it in the socket.
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5.5. SOIC Clip

Devices in SOIC package can be connected with SOIC CLIP (e.g. POMONA 5250 for SOIC-8 and POMONA 5252 for SOIC-16). Programming with a clip
is recommended only for advanced users (many traps for young players). Clip is a precision measuring device - before connecting the clip please
read chapters 5.1 — 5.4. Please follow tips below to avoid any accidental

damage to the clip:

e clip should be used only with SMD chips with SO-8 package (150mil
or 200mil),

e clip should NOT be used with physically damaged chips (not straight
pins or excess of tin),

e do NOT touch contact pins - any attempt of mechanical interference
will damage contact pins,

e it is NOT recommended to use the clip when device was previously
soldered in not professional way (pins may not contact to memory

pads; there is also risk of damage to the contact elements). In such

case it is recommend to use external adapter SOIC-8 150mil or
SOIC-8 200mil,

e it is NOT recommended to use the clip on a desoldered device (“in air”) - read and write may be incorrect (specially for fast devices, e.g. FLASH
SPI). All devices should be programmed in external circuit or in adapter, because only this method guarantees proper operations (in external
circuit there are additional filtering elements while external adapter guarantees the shortest connections). If you really need to connect
desoldered device in the clip, please do it very carefully. For FLASH SPI you should use as short wires as possible (5cm) and decrease SCK

frequency to 10% (Settings -> Options -> Hardware -> SCK = 10%). It not guarantees success but increases your chances.

-23 -



Connecting the CLIP

Connection schema is displayed in application during device selection. In most cases connection is straight ,,1 to 1” as you can see on the left picture
(programmer pin 1 should be connected to memory pin 1, programmer pin 2 to memory pin 2, pin 3 to pin 3 etc.). In some cases connection is not

straight, e.g. for 35080 memory (programmer pin 1 to memory pin 2, programmer pin 2 to memory pin 4 etc. - picture on the right).

—— = AR - m— = R
CEED i - 1 1 w3zl | Sy | | 2 /i\
'- e 2 []|C B 2 -4 o
| a“"i"“"az 8 | '. , :a“?”a& 8]
ss7e | S PNl - | se7s | 2o | ] CE| EEPROM )
geres 35 series
a = 2 :: 5| 31| 25 064 pry [ = = 2 : 7V 2] o0 [BJ
s B B . B 6
PP 7 st 5 | O =) PDBOD 7| |sf B 5
®EEWE 8~ 8 IFE)=F e g OEE®WE 88
Straight connection , 1 to 1” for FLASH SPI Not straight connection for 35080

First of all you should identify PIN 1 in the device®. Secondly you should connect wires to the clip and then clamp the clip on the device (so
connections will fit to schema). It is recommended to use dedicated ISP 10-pin socket in programmer. Please do not suggest with color of wires in tape

- only pin numbers are important. Example movie with POMONA CLIP connecting for 1-wire device: https://youtu.be/r2T78070xfQ?t=145

5 Pin no. 1 in the device is pointed with small dot in corner or with milled edge (as you can see at picture in schema above)
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5.6. Troubleshooting for in-circuit programming

If you can program device in programmer's socket (or adapter) with success, but you cannot program it in circuit than there are few things that you
can check. First of all, make sure that:

e all wires are connected properly (please take special care for pin contact in case of programming with SOIC CLIP),
e external circuit is powered properly and there is no voltage conflict on power bus,

« SPI lines: CS, (MOSI), (MISO) and (SCK) have pull-up resistors to power supply (4.7k - 10k),

« communication lines do not have additional elements, such as diodes, bus-switches, transistors etc.

e there is no communication conflict on the bus (e.g. processor and all other devices connected to shared SPI bus should be in RESET state).
Secondly, if problem still exist, there are still may be some tricky issues. Few examples with solutions below:

e noise and overshooting (communication errors, random read) - possible solutions:
o decrease SPI clock to 10% for FLASH SPI devices (menu Settings -> Options -> Hardware -> FLASH SPI SCK),
o impedance matching and termination for external circuit (and wires) by using e.g. termination resistors on signal wires. There is no universal

value of resistance (each circuit is different) but in most cases 100 - 1000 Ohm resistors in serial for CS, (MOSI) and (SCK) will be enough:

DEVICE PROGEAMMER
CS 470R 5
sib— e} uos|
50 MISO
5CK fb——[ 70 ——— SCk
SPI_SLAVE SPI_MASTER

o CS line decoupling (33pF - 220pF to ground as close as possible to the device in-circuit),

« to low voltage level during erasing and/or writing (erase error / communication error):
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o when external device (in external circuit) is powered from programmer, than there are also other devices powered too (on the same
power line) and due to higher current consumption output voltage may be too low for erase and write operations. In this case it is
recommended to set VPP slightly higher (e.g. +0.3V) or use external power source and set the same VPP level in application.

e bus conflict (random read or communication error during read):

o in some cases after device power up, the main processor is starting communication with slave devices (e.g. with memory you are trying
to read) - in this case it will be conflict on the bus (random read or communication error). All devices connected to the same
communication bus should be forced to be in RESET state. Sometimes it is enough to use external power supply and wait about 2-3
minutes for initial procedure finished and then try to communicate with the memory (when all devices are in idle state and bus is free).
The other tricky way is to use minimum voltage level to communicate with memory and this voltage level may be too low for other
devices so they will stay in RESET state and will not interrupt communication. On the other hand, to low voltage level may be not enough

to success for erase and write operations.

In some cases design of external circuit does not physically allow for in-circuit programming. In this case chip should be unsoldered and programmed in

programmer's socket or adapter.
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6. Custom Script Programming (I2C / SPI / 1-wire bus)

Custom script programming for I2C/SPI/1-wire bus in case of REVELPROG is a some kind of "bus pirate" tool for serial communication. This tool is still
in developement phase but it is already powerful and functional. With REVELPROG-IS Customs Script tool there is possibility to execute any
commands in any sequence with precise delays on SPI, I2C or 1-wire bus. You can write script to execute commands for unclocking device,

read and write hidden (or not) registers, change sector protection bits, write OTP registers and much more.

In practice it is also very useful tool for electronic enginners and embedded programmers, because there is possibility to communicate with any
serial (I2C, SPI and 1-wire) device. External device or module can be also powered from REVELPROG-IS (1.0 - 5.0V with 0.1V threshold). Only few

connection lines are required for communication (4 wires for SPI or 2 wires for I2C + optional 2 wires for external device power supply).

6.1. Script construction

Typical script consists of (1) #SCRIPT HEADER - information about com script Programming (alpha) O x
software version, (2) #HARDWARE SETTINGS - voltage selection (VPP), Script  Serpt maker  Information
bus selection (I2C/SPI) and communication speed, (3) #OPERATION (1  Fardware sefings

BuS: [P | wep: 33 [5] sPD: [sow ~

Scnpt

to n). Each script has to have at least one operation defined.

§S5CRIPT HEADER;
SCRIPT:wl.4.0;

of bytes to read/write, delay settings, (2) ‘INSTR’ instruction - sequence |iaee & s sroms

. . . . , . . $ODERATION;

of bytes for single instruction, (3) '‘DATA’ data to write (optional) - |0 o1 355 100 100 10008

INSTR:SF;

Each #OPERATION consists of (1) 'SW’ operation parameters: number

sequence of optional bytes for write after single instruction

Example construction of typical script with header (software version

v.1.6.0), hardware settings (SPI bus, 3.3V voltage, slowest speed) and

single operation with 1-byte 9Fh command is presented on right image:
Import Export Execute
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6.2. Script syntax

o "#" defines sections, e.g. #SCRIPT HEADER; (header), #HARDWARE SETTINGS; (hardware settings), #OPERATION; (for each operation),

. ;" is placed at the end of each command,
« "i"is placed directly after command words, e.g. SCRIPT: (script version), HW: (hardware settings), SW: (software settings - operation
parameters), INSTR: (instruction), DATA: (write data);

« "," separates parameters for each command (e.g. between "INSTR:" and ";" comma separates instruction bytes)
« "//" precedes comments which are ignored by script executor

Each script should have single #SCRIPT HEADER, single #HARDWARE SETTINGS and at least one #OPERATION (or more).

6.3. Script maker with GUI

Custom Script Programming (alpha) O

Script maker will help you prepare multiple operations with correct syntax. You o ., scgtmeker ifomaton

Software settings for single instruction

need to set few parameters for each operation:
WREN: RDEN: DBO: DAL DAW: DA BSYO: TOUT:
O B M4 & B e o B = 100 = 1000 |=
¢ WREN (Write Enable) + number of bytes to write in single operation,
Single instruction {1-16 bytes)

+ RDEN (Read Enable) + number of bytes to read in single operation, _ 8 5% 51 62 ok 6% 56 OX 0% o0 05 o oS 0O 0K Oe
« DBO (Delay Before Operation) - optional delay in ms before operation, ,,;,.'n.;;;,,;;;aﬂe”;;mim{opﬁml1_25%5}
- DAI (Delay After Instruction) - optional delay in ms after instruction, — L L L
« DAW (Delay After Write) - optional delay in ms after write,

« DAO (Delay After Operation) - optional delay in ms after operation,

e BSYO (Busy Operation) - maximum time in ms for write end (e.g. T

maximum wait time for busy flag in FLASH SPI or for ACK in I2C devices)

e TOUT (Timeout) - maximum PC timeout in ms for operation end (it is recommended to set timeout greater than sum of all other delays).
Please note that:

« Read/Write length are 0 based (0 means 1 byte, 255 means 256 bytes) and with WREN=0/RDEN=0 length parameter is ignored,
« "SW:" and "HW:" byte format is decimal,
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« "INSTR:" and "DATA:" byte format is hexadecimal.

Operation code generated by script maker from above example::

#OPERATI ON;
SWo,o0,1,3,5,5,10, 0, 100, 1000;
I NSTR: 9F;

As you can see SW parameters are equal to script maker parameters:

SW WREN[ 0- 1], W i t eLengt h[ 0- 255] , RDEN] 0- 1] , ReadLengt h[ 0- 255] , DBJ] 0- 250] , DAI [ 0- 250] , DAW 0- 250] , DAQ] 0- 250] , BSYQ[ 0- n] , TOUT[ 0- n] ;

6.4. Script execution sequence

Each script is executed with following sequence:

SET HW (BUS, VPP, SPEED)
EXECUTE OPERATION 1 (SET SW -> DBO -> INSTR -> DAI -> WRITE -> DAW -> BSYO -> READ -> DAO)
EXECUTE OPERATION 2

EXECUTE OPERATION N
RESET HARDWARE

oA wWwNRE

6.5. Script examples

Please take a look at forum tutorial for more information and script examples:

https://forum.reveltronics.com/viewtopic.php?f=22&t=280
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7. SFP / QSFP / XFP transceivers

REVELPROG-IS allows programming SFP, QSFP and XFP transceivers. Hardware adapter with SFP/QSFP/XFP connectors and external power supply is
required. MSA Standard is supported (e.g. SFF-8472, SFF-8636, INF-8077i). Special features allows to enter manufacturer / host password and
program write protected transceivers, brute force password (searching password for protected transceivers with unknown password), change

manufacturer info, model, serial number etc. and recalculate checksums directly from REVELPROG-IS application.

7.1. Adapter connection

Please connect external QSFP SFP XFP Adapter for REVELPROG-IS using
10-pin connector. Please connect power supply to adapter. Please insert
transceiver to dedicated transceiver slot. Only one transceiver should be
inserted at the same time.

Example of connected QSFP SFP XFP Adapter (please note that power supply
of adapter is also from PC USB port):
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7.2. Device selection and memory map

Please select transceiver type from memory database (EEPROM -> Transceivers -> SFP or QSFP or XFP).

7.2.1. SFP and SFP+
SFP [AO] and SFP [A2] allows to read/erase/write/verify of AOh and A2h blocks of SFP Transceivers.

These blocks may contain also diagnostic or write protected sectors, so verify may not pass for protected sectors.

SFP [USER] allows read/erase/write of any block or page
in memory map (verification should be done by user). The
[USER] mode allows to read/write specific part of memory.

In block AOh (256bytes) first 128bytes (00h - 7Fh) are for
serial ID and vendor information. It may be write protected
(password may be required). Second 128bytes (80h-FFh)
are reserved.

In block A2h (256bytes) first 127bytes (00h - 7Eh) are
diagnostic information (alarm and warning thresholds, cal
constants, real time diagnostics) and optional password
entry area. 128™ byte (7Fh) is page select byte (only if SFP
supports pages). Next 128 bytes (80h-FFh) is page content
(depends on selected page). SFP may not support A2h block
(it will be communication error) or page select (it may
contain only single page). Page 00h or 01h is User Writable
EEPROM (120bytes) and vendor specific (8bytes). Page 0
may be write protected (password may be required). Page
02h is for control functions. Pages 03h-7Fh are reserved.
Pages 80h-FFh are vendor specific.

2 wire address 1010000x (AOh)

2 wire address 1010001x (A2h)

Serial ID Defined by
SFP MSA (96 bytes)

55

95|

Alarm and Warning
Threshold (56 bytes)

Cal Constants
(40 bytes)

Vendor Specific
(32 bytes)

119

126

Real Time Diagnostic
Interface (24 bytes)

Vendor Specific (7 bytes)

Page Select Byte (Optional)

Reserved, SFF-8079
(128 bytes)
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7.2.2. QSFP and QSFP+

*» QSFP [USER] allows to read/erase/write of any block or page in QSFP/QSFP+ memory map (verification should be done by user). The [USER]
mode allows to read/write specific part of memory.

) o ) From To Content No. of Type
QSFP/QSFP+ contains only block AOh (256 bytes) divided into pages (byte bytes
. . 2-Wire Serial Add 1010000
7Fh in block AOh is page select byte). Pages are 128bytes length. Page 00h = Lgxerpa;ZSSOIl =
is required and provides static module identity and capabilities information 0 2 |ID and Status 3 Read-Only
. . . . 3 21 Interrupt Flags (Clear on read) 19 Read-Only
(it may be write protected with password). Other pages may be optional. 3 T Fre=Side Desice Moriiors o Read-Only
34 81 Channel Monitors 48 Read-Only
; _ 82 85 Reserved -4 Read-Only
Please che.c.k m_emory map for your QSFP/QSFP+ or in MSA Standard (SFF == = o Read/WiTts
8636 specification). 100 106 | Free Side Interrupt Masks 7 Read/Write
107 110 | Free Side Device Properties 4 Read-Only
. 111 112 | Assigned to PCI Express 2 Read/Write
With REVELPROG-IS you can select page from menu (you do not have to 113 116 | Free Side Device Properties 4 Read-Only
change page bytes manually in buffer) and read/write specific pages: F | U5 |Eesdred = BeadWHip
9¢€ pag y y ) / P pag 119 122 | Optional Password Change 4 Write-Only
123 126 | Optional Password Entry 4 Write-Only
127 127 | Page Select Byte 1 Read/Write
B Revelprog IS (v1.8.2) - O X Upper Page 00h
128 128 | Identifier 1 Read-Only
File | Edit View Tools Settings Help 129 191 Base ID Fields 63 Read-Only
) 4 ) 192 223 Extended ID 32 Read-Only
nANN R @ PP &R R 224|255 | Vendor Specific D E%) Read-Only
! cbin v +32 g e ) @ Page 01h (Optional)
_— QSR OSE . - — - s 128 | 255 | Reserved (previously for SFF-8079 support) [ 128 | Read-Only
) - ] < Page 02h (Optional)
S S Area: [Page Select (128byt | Page: (0[5 [ NoDelay 128 | 255 | User EEPROM Data [ 128 | Read/Write
T ) y , > Page 03h (Optional)

Y, [Fivisar core  |[rTLa10cDan-ns | REV: [ |s/N:[azisa7000s0 | oc: 181220 ] A, 58 T FreeSie Do Thrashoie 5 g
00 01 02 03 04 05 06 07 08 09 OA 0B 0C 0D OE OF A 176 223 | Channel Thresholds 48 Read-Only
0D 00 OC 04 00 00 00 40 40 02 D5 05 67 00 00 96 .......@@.0.g... 224 229 | TxEQ, Rx Output and TC Support 6 Read-Only
00 00 C8 00 46 49 4E 49 53 41 52 20 43 4F 52 50 ..E.FINISAR CORP 230 241 | Channel Controls 12 Read/Write
20 20 20 20 07 00 90 65 46 54 4C 34 31 30 51 44 ...eFTL410QD 242 351 | Channel Monitor Masks 10 Read/Write
G083 OF N 2 A 9% 5 P01 48 5B 2034 W 46 ¥ Shzzmavense 258 | 355 ieswed 4| Besis
20 20 20 20 31 38 31 31 32 30 20 20 3C 00 00 AS 181120 <..¥ 78 355 Verdor Soach ERges (e Tth (Optimay 58 Read /Wi
4E 4F 4B 49 41 50 34 36 30 38 35 36 34 37 34 33 NOKIAP4608564748 | | Vendor Specific _ | | Read/Write
39 39 41 00 00 00 00 00 00 00 00 00 00 00 00 00 99A............. Pages 20h-21h (Optional)

v 128 | 255 [PAM-4and WDM Features [ 128 [ Read/Write

Rddress: 0x0 Pages 22h-7Fh (Optional) .

Buffer size:  OxO - OX7F (128 Bytes) W:\Work\Projekty\QSFP\QSFP_NOKIA_FINISAR_AO_Page0.bin 128 | 255 [Reserved | 128 | Read/Write

- Pages 80h-Fh (Optional)
Programmer is connected (v1.8.2) Rt 128 | 255 | Vendor Specific [ 128 | Read/Write
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7.2.3. XFP

« XFP [USER] allows to read/erase/write of any block or table in QSFP/QSFP+
memory map (verification should be done by user). The [USER] mode allows to
read/write specific part of memory.

XFP contains only block AOh (256 bytes) divided into tables (byte 7Fh in block
AOh is table select byte). Tables are 128bytes length. Table 01h is default and
contains Serial ID Data. Table 02h is User EEPROM. Tables may be write
protected (password may be required for erase or write). Other pages may be
optional.

Please check memory map for your XFP or in MSA Standard (INF-8077i
specification).

With REVELPROG-IS you can select table from menu (you do not have to
change page bytes manually in buffer) and read/write specific tables.

7.3. Protected transceivers: manufacturer password and host password

255

2-Wire Serial Address
1010000X (AOH)

118

Digital
Diagnostic
Functions

119-122

4 Byte Password Change

126

4 Byte Password Entry

Page Select Byte Entry

\
128-\

Reserved

for Future
Diagnostic
Functions

223
224-

255

XFP MSA
Serial ID
Data

Vendor Specific
ID Data

User
EEPROM
Data

Vendor
Specific
Functions

255

Reserved

Table 00h

Table 01h

Table 02h

Table 03h-7Fh

Table 80h-FFh

Some transceivers also provides an optional password entry location that may be used to protect vendor internal function or user writable memory.

Password shall not be required to read any data, but it may be used for write protection for specific areas. Nor shall passwords be required to write any

controls defined in the digital diagnostics functions. Passwords may be used by vendors to control write access to MSA defined read only data for

factory setup, or to OEMs to limit write access in the User EEPROM area. Finally, passwords may be used to control read or write access to the vendor

specific pages or tables. Separate passwords value ranges will be defined to prevent accidental writing to critical module control areas. There are 2

types of passwords: manufacturer password and host password (also known as user password). You can enter password using password tool in

REVEPLROG-IS application.
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7.3.1. Host/User password

Host password is protecting User Writable EEPROM. Entering valid user password will unlock only user eeprom for erase and write operations.
Location of this area depends on transceiver type (please check memory map for your transceiver). In most cases user can change this password (if

current password is known). All factory new transceivers should have default host password: 00h 00h 10h 11h.

7.3.2. Manufacturer password Password tool for SFP/OSFP/XFP Transceivers *
Password
Manufacturer password is protecting whole memory map, e.g. serial number, product name, WE e
manufacturer name, vendor specific areas etc. Entering valid manufacturer password will unlock all 00 00 10 11 | § 00 00 10 11| 4

memory map for erase and write operations. Only manufacturer know this password, but

REVELPROG-IS provides tool for searching password with brute force method.
Search Password (brute force)

Location: |A2h,?Eh (SFP) " |

7.3.3. Hacking password (brute-force method) Access type: |H-:sthser |user eeprom) v|

Range limit: |ASCI| letters, number and special chars |

REVELPROG-IS password tool for transceivers can be also used to search password using brute

force method (checking all combinations or limited range of combinations). It uses smart algorithm | ®|

Write delay: |User select L

with auto-adjusting communication speed and delays to check as many password as possible in s T P
= ms

shortest time. For fastest MCU based transceivers it’s possible to check 4000 password combinations
Startfrom: |20 20 20 20

per second. Please check more details and on REVELTRONICS forum:
START STOP

https://forum.reveltronics.com/viewtopic.php?f=31&t=527

Searching SFP host/user password._.
checked 152500 from 81450625 (40713/s)
20h 30h 75h 38h ASCI: Oug
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8. Updates

New trends on the market and latest devices require from users newer and newer programming devices. Customer's satisfaction is our number one
priority and we share updates free of charge for all users of REVELPROG-IS. Update consist of software update (pc application) and firmware update
(software inside the device). Latest software can be downloaded directly from manufacturer’s webpage. You will be informed by the software about

possible updates after connecting out of date device.

Caution! If a firmware update process is interrupted, your programmer may not function properly. Updates are optional - warranty does not cover

damage due improper care.

During update process, device will start in DFU (Device Firmware Upgrade) mode. First time it may be necessary to install additional drivers (for DFU
mode). Windows should find drivers automatically on the Internet (if not, there are also available in /drivers/DFU subdirectory in the installation folder).
Installing drivers process should take about 30 seconds. If DFU drivers are installed, application will update the firmware device. Appropriate

instructions will be displayed before.

Warnings - read carsfully! &J-

Please close all other applications and disable antivirus software during update

process. Do not disconnect and do not connect any USB devices during update

process. Make sure that you have stable power supply for PC. ‘ eI

1) do not disconnect power supply from computer,

Update process may take about half a minute. Progress will be displayed on the I 2) do not disconnect the device frem PC, |

- - . 3} it is recommended to close all other applications,
screen. There is no possibility to cancel this process! After successful update,

Do NOT interrupt this process.

device will restart and will be ready to use. .
Interrupting this process could render your device NOT functional,

Continue?

Tak f Nie Anuluj
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9. Research and development

We are keen to still develop and improve the device. Please contact us at lab@reveltronics.com or visit our contact page at www.reveltronics.com if

you have any comments or tips about REVELPROG-IS.

Very welcome are ideas:

e« how to improve REVELPROG-IS - what functionality add to it,
« what chips add to supported device list in the next update (please suggest only serial I12C, SPI, uWire devices).

Repeated suggestions from many users will have more chance for implementation in the future. We encourage you to contact us because in this way

we already added many devices popular only in small segments of automotive market, computer service, RTV/AGD devices etc.
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10. APPENDIX A - List of supported devices

The following list details the family of supported devices (left column) with selected examples of supported memories (right column). Most chips

have the same programming procedures - programmer supports more devices than the examples given in the list.

9.1. EEPROM I2C 24... series

24AA01 | 24AA014 | 24AA014H | 24AA01H | 24C01 | 24C01A | 24C01B | 24C01C | 24LCO1 | 24LC014 | 24LCO14H | 24LCO1B | 24LCO1BH | AF24BCO1 | AT24C01 | AT24CO1A |
AT24C01B | BR24A01AF | BR24A01AF] | BR24CO01 | BR24CO1A | BR24CO1AF | BR24CO1AF] | BR24CO1AFV | BR24C21F | BR24C21F] | BR24C21FV | BR24G01 | BR24GO1F |
24..01 BR24GO1F] | BR24GO1FV | BR24GO1FVT | BR24L01 | BR24L0O1A | BR24LO1AF | BR24LO1AF] | BR24LO1AFV | BR24LO1AFVM | BR24LO1AFVT | BR24TO1A | CAT24AAO01 |
(1kb) CAT24C01 | CAT24C01B | CAT24C21 | CAT24FCO1 | CAT24LCO1 | CAT24WCO1 | CR24C01 | CY24C01 | FM24C01 | FT24C01 | FT24CO1A | GE24C01 | GP24BCO1 | HM24LCO1 |
HT24C01 | HT24LCO1 | IS24C01 | IS24C01B | LT24C01 | LX24C01 | M24CO01 | MM24C01 | S-24C01A | S-24C01B | S-24C01C | S-24CSO01A | SLA24C01 | SLE24CO01 | ST24C01 |
ST24WO01 | TMC24A01 | TU24CO1B | UG24C01 | X24012 | X24C01 | X24CO1A | XL24C01A

24AA02 | 24AA024 | 24AA024H | 24AA025 | 24AA02H | 24C02 | 24C02A | 24C02B | 24C02C | 24LCO2 | 24LC024 | 24LC024H | 24LC025 | 24LCO2B | 24LCO2BH | 24LCO2W |
24LLCO2 | A24C02 | ACE24C02 | ACE24LC02 | AF24BC02 | AM24LC02 | AT24C02 | AT24C02A | AT24C02B | AT24C02C | AT24HCO2B | AT24HC04B | AX24C02A | BIX25LCO2 |

BL24C02 | BR24A02F | BR24A02F] | BR24A02FVM | BR24C02 | BR24CO2F | BR24CO2FV | BR24GO2F | BR24G02F] | BR24GO2FVT | BR24L02 | BR24LO2F | BR24LO2F] |

BR24LO2FV | BR24LO2FVM | BR24LO2FVT | BR24T02 | CAT24AA02 | CAT24C02 | CAT24C03 | CAT24LC02 | CAT24LCO2A | CAT24LC02AZ | CAT24LC02Z | CAT24WCO2 |
24..02 = CAT24WCO03 | CKD24A02 | CR24C02 | CW24C02 | CW24C02B | CY24C02 | EC24C02 | EC24C02A | EM24LC02 | FM24C02 | FM24C02U | FM24C02UF | FM24C03U | FM24CO3UF |
(2kb) FT24C02 | FT24C02A | GE24C02 | GM24LC02B | GP24BC02 | HM24LC02 | HN58X2402 | HT24C02 | HT24LC02 | IN24AA02A | IN24AA02B | IN24LCO2B | IS24C02 | IS24C02A |
I1S24C02B | IS24C02E | K24C02 | KK24LC02B | L24C02 | L24W02 | LE24C0221 | LE24C023 | LE24L0221 | LT24C02 | LX24C02 | LY24C02 | M24C02 | MAX24A02 | MC24C02 |
MC24LC02 | MM24C02 | NM24C02 | NM24CO02F | NM24C02U | NM24C03 | NM24CO3F | NM24W02 | NSC24C02 | PCF8582C-2 | PTK24A02T | RT24A02 | S-24C02A | S-24C02B |
S-24C02C | S-24CS02A | SLA24C02 | SLE24C02 | SM24C02 | ST24C02 | ST24W02 | T24C02 | T24C02A | TMC24A02 | TU24C02B | UG24C02 | WS24C02 | X24022 | X24C02 |

XL24C02 | Y24LCO2

24AA04 | 24AA04H | 24C04 | 24CO4A | 24LC04 | 24LC04B | 24LCO4BH | A24C04 | ACE24C04 | ACE24LCO02 | AF24BC04 | AM24LC04 | AT24C04 | AT24C04A | AT24C04B |
AX24C04A | BIX24LC04 | BL24C04 | BR24A04F | BR24A04F] | BR24C04 | BR24C04F | BR24C04F] | BR24C04FV | BR24GO04F | BR24G04F] | BR24G0O4FV | BR24GO4FVT |

BR24L04 | BR24L04F | BR24L04F] | BR24L04FV | BR24L04FVM | BR24LO4FVT | BR24T04 | CAT24C04 | CAT24C05 | CAT24LC04 | CAT24WC04 | CAT24WCO5 | CR24C04 |

CW24C04 | CW24C04A | CY24C04 | EC24C04 | EC24C04A | FM24C04 | FM24C04U | FM24C04UF | FM24C05U | FM24CO5UF | FM24CL04 | FT24C04 | FT24C04A | GE24C04 |
GM24LC04B | HM24LC04 | HN58X2404 | HT24C04 | HT24LC04 | IN24LCO4B | IS24C04 | IS24C04A | IS24C04B | K24C04 | KK24LC04 | KK24LCO4B | L24C04 | L24W04 |

24..04
(4kb)
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LE24C042 | LE24C043 | LT24C04 | LX24C04 | LY24C04 | M24C04 | M24LC04 | MM24C04 | NM24C04 | NM24CO4F | NM24C04U | NM24C05 | NM24COS5F | NM24WO04 | S-24C04A |
S-24C04B | S-24CS04A | SLA24C04 | SLE24C04 | ST24C04 | ST24W04 | T24C04 | T24C04A | TMC24A04 | TU24C04B | UG24C04 | WS24W04 | X24042 | X24C04 | XL24C04 |
Y24LC04

24AA08 | 24AA08H | 24C08 | 24C08B | 24LCO8 | 24LCO8B | 24LCO8BH | 24LLCO8 | A24C08 | ACE24C08 | ACE24C08A | ACE24LCO8 | ACE24LCO8A | AF24BC08 | AM24LCO8 |
AT24C08 | AT24C08A | AT24C08B | AT24RFOSC | AX24CO8A | BL24C08 | BR24A0SF | BR24A08SF] | BR24C08 | BR24COSF | BR24CO8F] | BR24CO8FV | BR24GOSF | BR24GOSF] |
BR24GOSFV | BR24GOSFVT | BR24L08 | BR24LOSF | BR24LOSF] | BR24LOSFV | BR24LOSFVM | BR24LOSFVT | BR24T08 | CAT24C08 | CAT24LC08 | CAT24WC08 | CR24C08 |

24..08 CW24C08 | CW24C08B | CY24C08 | EC24C08 | EC24CO8A | FM24C08 | FM24C08U | FM24CO8UF | FM24CO9UF | FM24CLO8 | FT24C08 | FT24C08A | GM24LCO8B | GP24BCO8 |
(8kb) HN58X2408 | HT24C08 | HT24LCO8 | IN24AAO0SB | IN24LCO8B | IS24C08 | IS24C08A | K24C08 | KK24LCO8 | KK24LCO8B | L24MO08 | L24W08 | LE24C081 | LE24C082 |
LE24L082 | LT24C08 | LX24C08 | LY24C08 | M24C08 | MAX24A08 | MC24C08 | MC24LC08 | MM24C08 | MTV24C08 | MTV24LC08 | NM24C08 | NM24CO8F | NM24C08U |
NM24C09 | NM24CO9F | NM24C09U | NM24WO08 | NSC24C08 | P24S08 | PCA24S08 | PSO8 | PTK24A08T | S-24C08A | S-24C08C | S-24CS08A | SLA24C08 | SLE24C08 |

ST24C08 | ST24W08 | T24C08 | T24CO8A | TMC24A08 | TU24C08B | UG24C08 | WS24W08 | X24C08 | XL24C08 | Y24LCO8

24AA16 | 24AA16H | 24C16 | 24C16B | 24LC16 | 24LC164 | 24LC16B | 24LC16BH | 24LLC16 | 24U17 | A24C16 | ACE24C16 | ACE24LC16 | AF24BC16 | AM24LC16 | AT24C16 |

AT24C164 | AT24C16A | AT24C16B | AT24C16C | AX24C16A | BIX24LC16 | BL24C16 | BR24A16F | BR24A16F] | BR24C16 | BR24C16F | BR24C16F) | BR24C16FV | BR24E16 |
BR24E16F | BR24E16F] | BR24E16FV | BR24G16F | BR24G16F) | BR24G16FV | BR24G16FVT | BR24L16 | BR24L16F | BR24L16F] | BR24L16FV | BR24L16FVT | BR24S16F |

BR24S16F] | BR24S16FV | BR24S16FVM | BR24S16FVT | BR24T16 | CAT24C16 | CAT24C16L | CAT24C16Z | CAT24FC16 | CAT24FC17 | CAT24WC16 | CAT24WC17 | CR24C16 |
CW24C16 | CW24C16A | CY24C16 | EC24C16 | EC24C16A | FM24C16 | FM24C16U | FM24C16UF | FM24C17 | FM24C17U | FM24C17UF | FM24CL16 | FT24C16 | FT24C16A |

GM24LC16B | GP24BC16 | HM24LC16 | HN58X2416 | HT24C16 | HT24LC16 | IN24LC16B | IS24C16 | IS24C16A | KK24LC16 | KK24LC16B | L24W16 | LE24C162 | LE24L162 |

LT24C16 | LX24C16 | LY24C16 | M24C16 | MAX24A16 | MC24C16 | MC24LC16 | MM24C16 | MTV24C16 | MTV24LC16 | NM24C16 | NM24C16F | NM24C16U | NM24C17 |
NM24C17F | NM24C17U | NM24W16 | NSC24C16 | PTK24A16T | S-24C16A | S-24CS16A | SLA24C16 | SLE24C16 | SLE24C164 | ST24C16 | ST24W16 | T24C16 | T24C16A |
TMC24A16 | TU24C16B | UG24C16 | WS24W16 | X24164 | X24165 | X24C16 | XL24C16 | XL24C164 | Y24LC16

24..16
(16kb)

24AA32 | 24AA32A | 24C32 | 24LC32 | 24LC32A | 24LC32B | A24C32 | ACE24C32 | ACE24C32A | AF24BC32 | AT24C32 | AT24C32A | AT24C32B | AT24C32C | AT24C32D |
AX24C32A | BR24A32F | BR24A32F] | BR24C32 | BR24C32F | BR24G32F | BR24G32F) | BR24G32FV | BR24G32FVT | BR24L32 | BR24L32F | BR24L32F] | BR24L32FV |
24..32 | BR24L32FVT | BR24S32F | BR24S32F] | BR24S32FV | BR24S32FVM | BR24S32FVT | BR24T32 | CAT24C32 | CAT24FC32 | CAT24FC32A | CAT24WC32 | CAT24WC33 | CR24C32 |
(32kb) CW24C32 | EC24C32 | EC24C32A | FM24C32 | FM24C32U | FM24C32UF | FT24C32 | FT24C32A | HM24LC32 | HN58X2432 | HT24C32 | HT24LC32 | IN24AA32A | IS24C32 |
IS24C32A | IS24C32B | IS24C32C | K24C32 | L24W32 | LE24C322 | LE24L322 | M24C32 | MC24C32 | MM24C32 | NM24C32 | NM24C32U | NM24C32UF | NSC24C32 |
PTK24A32T | S-24C32C | SLA24C32 | SLE24C32 | ST24C32 | T24C32 | T24C32A | TU24C32 | WS24W32 | X24320

24AA64 | 24AA64F | 24AA65 | 24C64 | 24C65 | 24FC64 | 24LC64 | 24LC64B | 24LC64F | 24LC65 | A24C64 | ACE24C64 | ACE24C64A | AF24BC64 | AT24C64 | AT24C64A |
24..64 | AT24C64B | AT24C64C | AT24C64D | AX24C64A | BR24A64F | BR24A64F] | BR24C64 | BR24C64F | BR24G64F | BR24G64F] | BR24G64FV | BR24G64FVT | BR24L64 | BR24L64F
(64kb) | BR24L64F] | BR24S64F | BR24S64F] | BR24S64FV | BR24S64FVM | BR24S64FVT | BR24T64 | CAT24C64 | CAT24FC64 | CAT24FC65 | CAT24FC66 | CAT24WC64 | CAT24WC65
| CR24C64 | CW24C64 | EC24C64 | EC24C64A | FM24C64 | FM24C64F | FM24CL64 | FT24C64 | FT24C64A | HM24LC64 | HN58X2464 | HT24C64 | HT24LC64 | 1S24C64 |
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24..128
(128kb)

24..256
(256kb)

24..512
(512kb)

24..1024
(1Mb)

24..1025
(1Mb)

24..1026
(1Mb)

24..2048
(2Mb)

IS24C64A | IS24C64B | K24C64 | L24W64 | LE24CB642 | M24C64 | MM24C64 | NM24C65 | NM24C65F | NSC24C64 | PTK24A64T | S-24C64C | SLA24C64 | SLE24C64 | ST24C64
| T24C64 | T24C64A | TU24C64B | WS24W64 | X24640 | X24641 | X24645

24AA128 | 24C128 | 24FC128 | 24LC128 | 24LC21 | 24LC21A | 24LCS21A | ACE24C128 | AF24BC128 | AT24C128 | AT24C128B | AT24C128C | AT24CS128 | AX24C128A |
BL24C128 | BR24G128F | BR24G128F] | BR24G128FV | BR24G128FVT | BR24S128F | BR24S128F] | BR24S128FV | BR24S128FVT | BR24T128 | CAT24C128 | CAT24WC128 |
CAT24WC129 | CR24C128 | CW24C128 | EC24C128 | EC24C128A | FM24C128 | FM24C128F | FM24CL128 | FT24C128 | FT24C128A | HN58X24128 | HT24C128 | HT24LC128 |
1S24C128 | IS24C128A | IS24C128B | IS24L128 | LE24CB1283 | M24128 | S-24C128C | T24C128 | T24C128A | TU24C128

24AA256 | 24C256 | 24FC256 | 24LC256 | A24C256 | ACE24C256 | AT24C256 | AT24C256B | AT24C256C | AT24CS256 | AX24C256A | BL24C256 | BR24S256F | BR24S256F] |
BR24T256 | CAT24C256 | CAT24FC256 | CAT24WC256 | CAT24WC257 | CW24C256 | EC24C256A | FM24C256 | FM24C256F | FM24CL256 | FT24C256 | FT24C256A |
HN58X24256 | HT24C256 | HT24LC256 | 1S24C256 | IS24C256A | 1S24L256 | M24256 | MC24C256 | T24C256 | T24C256A | TU24C256

24AA512 | 24C512 | 24FC512 | 24LC512 | AT24C512 | AT24C512B | AT24C512C | CAT24C512 | CAT24WC512 | FM24C512 | FM24CL512 | FT24C512A | HN58X24512
HT24C512 | HT24LC512 | IS24C512 | M24512 | SA24C512

24AA1024 | 24C1024 | 24FC1024 | 24LC1024 | AT24C1024 | AT24C1024B | CAT24C1024 | CAT24WC1024 | FM24C1024 | FM24CL1024 | M24M01 | HT24C1024 | HT24LC1024 |
1S24C1024

24AA1025 | 24C1025 | 24LC1025

24AA1026 | 24C1026 | 24LC1026

M24M02
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9.2. EEPROM SPI 25... series

25..010
(1kb)

25..020
(2kb)

25..040
(4kb)

25..080
(8kb)

25..160
(16kb)

25..320
(32kb)

25..640
(64kb)

25..128
(128kb)

25..256
(256kb)

25..512
(512kb)

25..1024
(1Mb)

25010 | 25AA010 | 25AA010A | 25C010 | 25LC010 | 25LC010A | A25010A | AT25010 | BR25H010-W | BR25L010-W | CAT25C01 | CAT25C11 | CY25C01 | IS25C01 | S-25A010A
| ST25C01 | ST25W01 | XC25010

25020 | 25AA020 | 25AA020A | 25C020 | 25LC020 | 25LC020A | AT25020 | AT25020A | BR25H020-W | BR25L020-W | CAT25C02 | CAT25C03 | CY25C02 | FM25C020U |
FM25C020UL | IS25C02 | NM25C020 | S-25A020A | ST25C02 | ST25W02 | X25020 | XC25020

25040 | 25AA040 | 25AA040A | 25C040 | 25C040A | 25L.C040 | 25LCO40A | AT25040 | AT25040ACAT25C04 | BR25H040-W | BR25L040-W | CAT25C05 | CY25C04 | FM25C040U
| FM25C040UL | FM25C041U | FM25L04 | IN25AA040 | IS25C04 | NM24C040 | NM24C041 | S-25A040A | ST25C04 | ST25W04 | X25040 | X25041 | XC25040

25080 | 25AA080 | 25AA080A | 25AA080B | 25C080 | 25LCO80 | 25LCO80A | 25LC080B | AT25080 | AT25080A | AT25080B | BR25H080-W | BR25L080-W | CAT25C08 |
CAT25C09 | CY25C08 | FM25L08 | IN25AA080 | IS25C08 | S-25A080A | ST25C08 | ST25W08 | X25080 | X25F008 | XC25080

25160 | 25AA160 | 25AA160A | 25AA160B | 25C160 | 25LC160 | 25LC160A | 25LC160B | AT25160 | AT25160A | AT25160B | BR25H160-W | BR25L160-W | CAT25C16 |
CAT25C17 | CY25C16 | FM25C160 | FM25C160U | FM25C160UL | FM25L016 | IN25AA160 | IS25C16 | NM24C160 | S-25A160A | ST25C16 | ST25W16 | X25160 | X25170 |
X25F016 | XC25160

25320 | 25AA320 | 25AA320A | 25C320 | 25LC320 | 25LC320A | AT25320 | AT25320A | AT25320B | BR25H320-W | BR25L320-W | CAT25C32 | CAT25C33 | FM25C320U |
FM25C320UL | IS25C32 | IS25C32A | IS25C32B | S-25A320A | TI2532 | X25320 | X25F032 | XC25320

25640 | 25AA640 | 25C640 | 25LC640 | AT25640 | AT25640A | AT25640B | BR25L640-W | CAT25C64 | CAT25C65 | FM25C640U | FM25CL64 | FM25L64 | IS25C64 | IS25C64A |
IS25C64B | NM24C640 | S-25A640A | TI2564 | X25640 | X25642 | X25650 | X25F064 | XC25640

25128 | 25AA128 | 25C128 | 25LC128 | AT25128 | AT25128A | CAT25C128 | IS25C128 | IS25C128A | S-25C128A | X25128 | X25138 | X25F128 | XC25128

25256 | 25AA256 | 25C256 | 25LC256 | AT25256 | AT25256A | CAT25C256 | FM25L256 | IS25C256 | IS25C256A | X25256 | XC25256

25512 | 25AA512 | 25C512 | 25LC512 | AT25512 | XC25512

251024 | 25AA1024 | 25C1024 | 25LC1024 | AT251024 | XC251024
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9.3. EEPROM SPI 35... series

NOTE: Incremental register (first 32 bytes) can be written only with higher value.

35..080

(8Kkb) D80DOWQ | D8ODOWQ | M35080 | M35080-3 | M35080-6 | M35080V6 | M35080-VP
35..160

(16kb) D160DOWQ | D160DOWT | D160DOWQ | D160DOWT | M35160

9.4. EEPROM SPI 90... series

ROHM: BR9010 | BR9020 | BR9040
(1kbit - 4kbit)

9.5. EEPROM SPI 95... series

(1kbit - 2Mbit) M95010, M95020, M95040, M95080, M95160, M95320, M95640, M95128, M95256, M95512, M95M01, MO95M02

95P08

5P08 | 5PO8C3 | 95P08
(8kbit)
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9.6. EEPROM MICROWIRE 93... series

93..06
(256b)

93..46
(1kb)

93546
(1kb)

93..56
(2kb)

Supported both addressing (8-bit and 16-bit) modes.

9306 | 93C06 | KM93C06 | KM93C06GD | M93C06 | NMC9306 | NMC93CO6L | NMC93C06LZ

93AA46 | 93AA46A | 93AA46B | 93AA46C | 93C46 | 93C46A | 93C46B | 93C46C | 93CX46 | 93LC46 | 93LCA6A | 93LC46B | 93LC46C | 93X46 | A93C46(x16) | A93C46(X8) |
AF93BC46(x16) | AF93BC46(x8) | AK93C46 | AMO3LC4A6 | AT93C46(x16) | AT93C46(x8) | ATO3C46A | AT93C46B | AT93C46C | AT93C46D(x16) | AT93C46D(x8) | AT93CA6E |
BL93C46(x16) | BLO3C46(x8) | BRO3A46 | BRO3C46 | BRO3H76 | BRO3L46 | BRO3LCA6 | CATO3C46(x16) | CAT93C46(x8) | CATO3C46A | CATI3C46AH | CAT93C46B(x16) |
CAT93C46B(x8) | CAT93C46H(x16) | CAT93C46H(x8) | CATO3C46R(x8) | CATI3HC46(x16) | CATO3HC46(x8) | CRO3C46(x16) | CRO3C46(x8) | ECO3C46A(x16) | ECO3C46A(X8) |
EM93LC46(x16) | EM93LC46(x8) | FM93C46 | FMI3C46A(x16) | FMO3C46A(X8) | FT93C46(x16) | FT93C46(x8) | FT93C46A(x16) | FTO3C46A(x8) | GSCO3BCA6A(X16) |
GSC93BC46A(x8) | GT93C46(x16) | GTI3C46(x8) | GTI3C46A(x16) | GTI3CA6A(X8) | HTO3LCA6-A(x16) | HTO3LCA6-A(x8) | INO3AA46A | IN93AA46B | INO3AA46C(x16) |
IN93AA46C(x8) | IN93LC46A | IN93LC46B | IN93LCA6C(x16) | INO3LCA6C(x8) | IS93C46-3 | IS93CA6A(x16) | IS93C46A(X8) | IS93C46AGR(x16) | ISO3CA6AGR(x8) | IS93C46B |
IS93C46BGR | 1S93C46D(x16) | 1S93C46D(x8) | IS93C46DGR(x16) | IS93C46DGR(x8) | K93C46 | KMI3C46 | KMI3C46GD | KMO3C46V | KMO3C46VGD | LC46 | M93C46(x16) |
M93C46(x8) | MAX93LC46 | MC93C46 | MM93C46-3 | MM93C46-3GR | NM93C46 | NM93C46A | NMI3C46A(x16) | NMI3C46A(x8) | NMO3C46L | NM93C46LZ | NMC9346 |
PTK93LC46(x16) | PTK93LC46(x8) | RH76 | RT93LC46(x16) | RTO3LC46(x8) | S93462 | S93463 | S93A46 | S-93A46A | S-93A46B | S-93L46AD | S93VP462 | S93VP463 |
S93WD462 | S93WD463 | T93C46(x16) | TO3C46(x8) | TO3C46A(X16) | TO3C46A(x8) | TMCI3LC4A6 | TMCO3LCA6(x16) | TMCI3LCA6(x8) | TUI3CA6(x16) | TUI3CA6(x8) |
UG93C46-A(x16) | UG93C46-A(x8) | WO3C46 | WI3C46B(x16) | WI3C46B(x8) | XL93C46 | XLO3LC46 | XLO3LCA6A | XLO3LCA6ARY | XLIO3LCA6B(x16) | XLO3LCA6B(x8) |
XL93LC46BRY(x16) | XLO3LC46BRY(x8) | XLO3LCA6RY | YO3LC46(x16)

93546 | M93546 | NM93CS46

93AA56 | 93AA56A | 93AA56B | 93AAS6C | 93C56 | 93C56A | 93C56B | 93C56C | 93CX56 | 93LC56 | 93LC56A | 93LC56B | 93LC56C | 93X56 | A93C56(x16) | A93C56(X8) |
AF93BC56(x16) | AF93BC56(x8) | AK93C56 | AM93LC56 | AT93C56(x16) | AT93C56(x8) | AT93C56A | AT93C56B | AT93C56C | AT93C56D(x16) | AT93C56D(x8) | AT93CS6E |
AT93C57(x16) | AT93C57(x8) | BLO3C56(x16) | BLO3C56(x8) | BRO3A56 | BRO3C56 | BRO3L56 | BRO3LC56 | CAT93C56(x16) | CAT93C56(x8) | CAT93C56A | CAT93C56AH |
CAT93C56B(x16) | CAT93C56B(x8) | CAT93C56H(x16) | CAT93C56H(x8) | CAT93C56R(x8) | CAT93C57(x16) | CAT93C57(x8) | CAT93HC56(x16) | CAT93HC56(X8) |
CR93C56(x16) | CR93C56(x8) | EC93C56A(x16) | EC93C56A(x8) | EMO3LC56(x16) | EMO3LC56(x8) | EMI3LC57(x16) | EMI3LC57(x8) | FMI3C56 | FMO3C56A(X16) |
FM93C56A(x8) | FT93C56(x16) | FT93C56(x8) | FT93C56A(x16) | FT93C56A(X8) | GSCI3BC56A(x16) | GSCI3BCS56A(X8) | GTI3C56(x16) | GTI3C56(x8) | GTI3C56A(X16) |
GT93C56A(x8) | HT93LC56-A(x16) | HT93LC56-A(x8) | INO3AAS6A | IN93AASEB | IN93AA56C(x16) | IN93AAS6C(x8) | IN93LC56A | IN93LC56B | INO3LC56C(X16) |
IN93LC56C(x8) | IS93C56-3 | ISO3C56A(x16) | IS93C56A(x8) | IS93C56AGR(x16) | IS93C56AGR(x8) | IS93C56B | IS93C56BGR | 1S93C56D(x16) | IS93C56D(x8) |
I1S93C56DGR(x16) | IS93C56DGR(x8) | K93C56 | KMI3C56 | KMI3C56GD | KM93C56V | KM93C56VGD | KMI3C57(x16) | KM93C57GD(x16) | KM93C57V(x16) | M93C56(x16) |
M93C56(x8) | MC93C56 | MM93C56-3 | MM93C56-3GR | NM93C56 | NM93C56A | NMI3C56A(x16) | NMI3C56A(x8) | NM93C56L | NM93C56LZ | PTK93LC56(x16) | PTK93LC56(x8)

-42 -



| S-93A56A | S-93A56B | S-93L56AD | T93C56(x16) | T93C56(x8) | T93C56A(x16) | T93C56A(x8) | TMCI3LC56 | TMCI3LC56(x16) | TMCI3LC56(x8) | TMCI3LC57(x16) |
TMC93LC57(x8) | TU93C56(x16) | TU93C56(x8) | UG93C56-A(x16) | UG93C56-A(x8) | UG93C56-C | WI3C56 | WO3C56B(x16) | WO3C56B(x8) | XL93C56 | XLI3LCS6 |
XL93LC56A | XL93LC56ARY | XLO3LC56B(x16) | XL93LC56B(x8) | XL93LCS56BRY(x16) | XL93LC56BRY(x8) | XL93LC56RY | YO3LC56-A(x16)

93556

(2kb) 93S56 | M93S56 | NM93CS56 | ST93CS56 | ST93CS57

93AA66 | 93AAG6A | 93AA66B | 93AA66C | 93C66 | 93C66A | 93C66B | 93C66C | 93CX66 | 93LC66 | 93LCE6A | 93LCE6B | 93LC66C | 93X66 | A93C66(x16) | A93CE6(X8) |
AF93BC66(x16) | AF93BC66(x8) | AK93C66 | AMI3LCE6 | ATO3C66(x16) | AT93C66(x8) | ATO3CE6A | AT93C66B | ATI3C66C | AT93C66D(x16) | ATI3C66D(x8) | ATO3CE6E |
BL93C66(x16) | BLO3C66(x8) | BRO3A66 | BRO3C66 | BRO3LE6 | BRO3LCE6 | CATI3C66(x16) | CATI3C66(x8) | CATO3C66A | CATI3C66AH | CATI3C66B(x16) | CAT93C66B(x8) |
CAT93C66H(x16) | CAT93C66H(x8) | CAT93C66R(x8) | CATI3HCE6(x16) | CATO3HCE6(x8) | CRO3C66(x16) | CRI3CE6(X8) | ECO3CE66A(X16) | ECO3CE66A(X8) | EMI3LCE6(x16) |
EM93LC66(x8) | FM93C66 | FMI3CE6A(X16) | FMO3C66A(x8) | FT93C66(x16) | FTO3C66(x8) | FTO3C66A(X16) | FTO3C66A(X8) | GSCI3BCE6A(X16) | GSCI3BCE6A(XS) |
GT93C66(x16) | GTI3C66(x8) | GTI3C66A(X16) | GTO3C66A(x8) | HTI3LC66-A(x16) | HTO3LC66-A(x8) | INO3AAGGA | IN93AAG6B | IN93AAG6C(x16) | INO3AAG6C(X8) |
IN93LC66A | IN93LCE6B | INO3LC66C(x16) | IN93LC66C(x8) | IS93C66-3 | IS93C66A(X16) | ISO3CE6A(x8) | ISO3C66AGR(x16) | IS93C66AGR(X8) | IS93C66B | ISO3C66BGR |
1S93C66D(x16) | 1S93C66D(x8) | ISO3C66DGR(x16) | IS93C66DGR(x8) | K93C66 | KMOI3C66 | KMO3C66GD | KMI3C66V | KMI3C66VGD | KM93C67(x16) | KM93C67GD(x16) |
KM93C67V(x16) | M93C66(x16) | M93C66(x8) | MCI3C66 | MM93C66-3 | MM93C66-3GR | NMI3C66 | NMO3C66A | NMI3C66A(x16) | NMI3C66A(x8) | NMI3C66L | NMI3CE6LZ |
PTK93LC66(x16) | PTK93LC66(x8) | S93662 | S93663 | S93A66 | S93A66A | S-93A66A | S-93A66B | S-93L66AD | S93VP662 | S93VP663 | S93WD662 | S93WD663 |
T93C66(x16) | T93C66(x8) | TO3C66A(X16) | TO3C66A(x8) | TMCI3LCE6 | TMCO3LCE6(x16) | TMCI3LCE6(X8) | TUIZCH6(x16) | TUIZCH6(x8) | UGI3CE6-A(x16) | UG93CE6-
A(x8) | W93C66 | W93C66B(x16) | WO3C66B(x8) | XLI3C66 | XLI3LCE6 | XLI3LCE6A | XLO3LCE6ARY | XLO3LCE6B(x16) | XLI3LC66B(x8) | XLI3LCE6BRY(x16) |
XL93LC66BRY(x8) | XLO3LCE6RY | YO3LCE6-A(x16)

93..66
(4kb)

93566

93566 | M93S66 | NM93CS66
(4kb)

93AA76 | 93AA76A | 93AA76B | 93AA76C | 93C76 | 93C76A | 93C76B | 93C76C | 93CX76 | 93LC76 | 93LC76A | 93LC76B | 93LC76C | 93X76 | A93C76(x16) | A93C76(x8) |
AF93BC76(x16) | AF93BC76(x8) | AK93C76 | AMI3LC76 | AT93C76(x16) | AT93C76(x8) | AT93C76A | AT93C76B | AT93C76C | AT93C76D(x16) | AT93C76D(x8) | AT93C76E |
BL93C76(x16) | BL93C76(x8) | BR93A76 | BRO3C76 | BRO3L76 | BRO3LC76 | CATI3C76(x16) | CATI3C76(x8) | CAT93C76A | CAT93C76AH | CAT93C76B(x16) | CAT93C76B(x8) |
CAT93C76H(x16) | CAT93C76H(x8) | CAT93C76R(x8) | CATI3HC76(x16) | CATO3HC76(x8) | CRO3C76(x16) | CRO3C76(x8) | EC93C76A(x16) | EC93C76A(x8) | EMI3LC76(x16) |
93..76 EM93LC76(x8) | FM93C76 | FM93C76A(x16) | FM93C76A(x8) | FT93C76(x16) | FT93C76(x8) | FT93C76A(x16) | FT93C76A(x8) | GSCI3BC76A(x16) | GSCI3BC76A(X8) |
(8kb) GT93C76(x16) | GT93C76(x8) | GT93C76A(x16) | GT93C76A(x8) | HT93LC76-A(x16) | HTO3LC76-A(x8) | INO3AA76A | IN93AA76B | IN93AA76C(x16) | INO3AA7EC(x8) |
IN93LC76A | IN93LC76B | IN93LC76C(x16) | IN93LC76C(x8) | IS93C76-3 | IS93C76A(x16) | ISO3C76A(X8) | IS93C76AGR(x16) | ISO3C76AGR(x8) | IS93C76B | IS93C76BGR |
1S93C76D(x16) | 1S93C76D(x8) | IS93C76DGR(x16) | IS93C76DGR(x8) | K93C76 | KMI3C76 | KMI3C76GD | KMI3C76V | KM93C76VGD | M93C76(x16) | MO3C76(x8) | MCI3C76
| MM93C76-3 | MM93C76-3GR | NM93C76 | NMI3C76A | NM93C76A(x16) | NMI3C76A(x8) | NM93C76L | NMO3C76LZ | PTK93LC76(x16) | PTK93LC76(x8) | S-93A76A | S-93A76B
| S-93L76AD | T93C76(x16) | T93C76(x8) | T93C76A(x16) | T93C76A(x8) | TMCI3LC76 | TMCI3LC76(x16) | TMCI3LC76(x8) | WI3C76 | WO3C76B(x16) | WO3C76B(x8) |
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XL93C76 | XL93LC76 | XLO3LC76A | XLO3LC76ARY | XL93LC76B(x16) | XL93LC76B(x8) | XL93LC76BRY(x16) | XLO3LC76BRY(x8) | XLO3LC76RY

93AA86 | 93AAB6A | 93AAB6B | 93AA86C | 93C86 | 93C86A | 93C86B | 93C86C | 93CX86 | 93LC86 | 93LCB6A | 93LC86B | 93LC86C | 93X86 | A93C86(x16) | A93C86(X8) |
AF93BC86(x16) | AF93BC86(x8) | AK93C86 | AMI3LC86 | AT93C86(x16) | AT93C86(x8) | AT93C86A | AT93C86B | ATI3C86C | AT93C86D(x16) | AT93C86D(x8) | AT93CS6E |
BL93C86(x16) | BLO3C86(x8) | BRO3AS6 | BRO3C86 | BRO3L86 | BRO3LCS6 | CATI3C86(x16) | CATI3C86(x8) | CAT93C86A | CAT93C86AH | CAT93C86B(x16) | CAT93C86B(x8) |
CAT93C86H(x16) | CAT93C86H(x8) | CAT93C86R(x8) | CATI3HC86(x16) | CATO3HCS6(x8) | CRO3C86(x16) | CRO3C86(x8) | EC93C86A(X16) | EC93C86A(X8) | EMI3LC86(x16) |
o3 86 EM93LC86(x8) | FM93C86 | FM93C86A(x16) | FMO3C86A(x8) | FT93C86(x16) | FT93C86(x8) | FT93C86A(X16) | FTO3C86A(x8) | GSCI3BC86A(x16) | GSCI3BCB6A(XS) |
(16kb) GT93C86(x16) | GTI3C86(x8) | GTI3C86A(x16) | GTO3C86A(x8) | HT93LC86-A(x16) | HTO3LC86-A(x8) | INO3AABEA | IN93AAB6B | IN93AAS6C(x16) | INO3AABEC(xS) |
IN93LC86A | IN93LC86B | IN93LC86C(x16) | IN93LC86C(x8) | IS93C86-3 | IS93C86A(x16) | ISO3C86A(X8) | ISO3C86AGR(x16) | ISO3C86AGR(X8) | IS93C86B | IS93C86BGR |
1S93C86D(x16) | 1S93C86D(x8) | IS93C86DGR(x16) | IS93C86DGR(x8) | K93C86 | KMI3C86 | KMI3C86GD | KM9I3C86V | KM93C86VGD | M93C86(x16) | MO3C86(x8) | MCI3C86
| MM93C86-3 | MM93C86-3GR | NM93C86 | NMI3C86A | NM9I3C86A(x16) | NMI3C86A(x8) | NMI3C86L | NMO3C86LZ | PTKO3LC86(x16) | PTKI3LC86(x8) | S93A86 | S93A86A |
S-93A86A | S-93A86B | S-93L86AD | T93C86(x16) | T93C86(x8) | TO3C86A(X16) | TO3C86A(X8) | TMCI3LC86 | TMCO3LC86(x16) | TMCI3LCE6(x8) | WI3C86 | WO3C86B(x16) |
W93C86B(x8) | XL93C86 | XL93LC86 | XLI3LC86A | XLO3LC86ARY | XLO3LC86B(x16) | XLIO3LCB6B(x8) | XLO3LC86BRY(x16) | XLO3LC8E6BRY(x8) | XLO3LCS6RY

9.7. EEPROM 1-Wire

24..30

DS2430A
(256b)
24..31

DS2431
(1kb)
24..33

DS2433 | DS24B33

(4kb)
Other DS2436
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9.8. FLASH SPI 25... series
Supports low-voltage serial flash memories (1.5V, 1.8V, 2.5V) and standard (3.3V)

25..05
(512kb)

25..010
(1Mb)

25..020
(2Mb)

25PExx
(2Mb)

25..040
(4Mb)

25PExx
(4Mb)

25..080
(8Mb)

A25LO5P | A25L512 | A25L512A | A25LS512A | AC25LV512 | AT25DL5121 | AT25DN512C | AT25F512 | AT26DF5121 | EN25B05 | EN25F05 | EN25P05 | F25D512Q |
F25L0512 | F25L05P | F25L05PA | F25L512P | F25L512Q | GD25D05C | GD25Q05 | GD25WD05C | KH25L512 | M25P05 | M25P05-A | MS25X512 | MX25L512 | MX25L5121 |
MX25L5121E | MX25L512C | MX25L512E | MX25R512F | MX25U5121E | MX25V512 | MX25V5121E | MX25V512C | MX25V512E | MX25V512F | PM25LD512 | PM25LV512 |
PM25LV512A | SA25F005 | SST25VF512 | SST25VF512A | SST25WF512 | SST25WF512B | W25Q05CL | W25Q05CV | W25X05CL
A25L010 | A25L010A | A25L10P | AC25LV010 | AT24F1024 | AT25DNO11 | AT25FS010 | EN24LF10 | EN25B10 | EN25F10 | EN25LF10 | EN25P10 | EN25510 | ES25P10 |
F25L01P | F25L01PA | GD25D10C | GD25Q10 | GD25WD10C | IS25CD010 | IS25LQ010B | KH25L1005 | LE25FU106 | LE25FU106B | M25P10 | M25P10-A | M25PE10 |
MS25X10 | MX25L1005 | MX25L1005C | MX25L1005ZM | MX25L1006 | MX25L1006E | MX25L1021 | MX25L1021E | MX25L1025 | MX25L1025C | MX25L1026 | MX25L1026E |
MX25R1035F | MX25U1001E | MX25V1006 | MX25V1006E | MX25V1035F | NX25P10 | PM25LD010 | PM25LV010 | PM25LVO10A | S25FLO01D | SA25F010 | SST25VF010 |
SST25VFO010A | SST25WF010 | TS25L010A | W25D10V | W25P10V | W25Q10BV | W25Q10CL | W25Q10CV | W25Q10EW | W25X10AV | W25X10BL | W25X10BV | W25X10CL
| W25X10L | W25X10V
A25L020 | A25L020C | A25L20P | AT25DF021 | AT25F2048 | AT25F2048N | EN25B20 | EN25F20 | EN25LF20 | EN25P20 | EN25S20 | ES25P20 | F25D02P | F25D02QA |
F25L02P | F25L02PA | GD25D20C | GD25Q20B | GD25Q21B | GD25WD20C | 1S25LQ020 | IS25WD020 | IS25WP020D | IS25WQ020 | KH25L2005 | LE25FU206 | LE25S20 |
LE25U20 | M25P20 | M25PE20 | M25U2033E | MS25X20 | MX25L2005 | MX25L2005C | MX25L2005ZM | MX25L2006 | MX25L2025C | MX25L2026E | MX25L26C |
MX25R2035F | MX25U2032E | MX25U2033E | MX25U2035F | MX25V2006E | MX25V2033F | MX25V2035F | NX25P20 | PM25LD020 | PM25LV020 | S25FL002D | SA25F020 |
SST25VF020 | SST25VF020A | SST25VF020B | SST25WF020 | SST25WF020B | TS25L020A | W25D20V | W25P20V | W25Q20BW | W25Q20CL | W25Q20CV | W25Q20EW |
W25X20BL | W25X20BV | W25X20CL | XM25QU20B

AT25PE20 | AT25PE20[P264]

A25L040 | A25L040A | A25L40P | AT25DF041 | AT25DF041A | AT25F4096 | AT25FF041A | AT25FS040 | AT25SF041 | AT26F004 | EN25B40 | EN25F40 | EN25LF40 |
EN25P40 | EN25Q40 | EN25S40 | EN25T40 | ES25M40 | ES25P40 | F25D04Q | F25D04QA | F25L004 | F25L04P | F25L04PA | GD25D40C | GD25LQ40 | GD25Q40B |
GD25Q41B | GD25WD40C | IS25LD040 | IS25LQ040B | IS25WD040 | IS25WP040 | IS25WP040D | IS25WQ040 | KH25L4005A | KH25L4006E | LE25FS406 | LE25FU406B |
LE25S40 | LE25U40 | M25P40 | M25PE40 | MS25X40 | MX25L4005 | MX25L4005A | MX25L4005C | MX25L4006E | MX25L4025C | MX25L4026E | MX25R4035F | MX25U4032F
| MX25U4033E | MX25U4035 | MX25U4035F | MX25V4005 | MX25V4005C | MX25V4006E | MX25V4035 | NX25P40 | PM25LD040 | PM25LV040 | S25FL004 | S25FLO04A |
S25FL004K | S25FL204K | SA25F040 | SST25VF040 | SST25VF040A | SST25VF040B | SST25WF040 | SST25WF040B | W25D40V | W25P40V | W25Q40BL | W25Q40BV |
W25Q40BW | W25Q40CL | W25Q40EW | W25X40AL | W25X40AV | W25X40BL | W25X40BV | W25X40CL | W25X40L | W25X40V | XM25QH40B | XM25QU40B

AT25PE40 | AT25PE40[P264]

A25L080 | A25L80P | AT25DF081 | AT25DFO81A | AT25DL081 | AT25FFO81A | AT25SF081 | AT26DF081 | EN25B80 | EN25D80 | EN25F80 | EN25P80 | EN25Q80 | EN25Q80A
| EN25S80 | EN25T80 | ES25M80 | ES25P80 | F25D08QA | F25L08QA | FM25Q08 | FM25Q08A | GD25D80C | GD25LQ80 | GD25Q80B | GD25Q80C | GD25WDS0C |
1S25LP08OD | 1S25LQ080 | IS25LQ080B | IS25WP080 | IS25WP080D | KH25L8005 | KH25L8006E | KH25L8036D | LE25S81 | M25P80 | M25PESO | M25PX80 | M25X80 |

- 45 -



MS25X80 | MX25L8005 | MX25L8005ZM | MX25L8006E | MX25L8008E | MX25L8035E | MX25L8036E | MX25L8073E | MX25L8075E | MX25R8035F | MX25U8032E |
MX25U8033E | MX25U8035 | MX25U8035E | MX25U8035F | MX25V8005 | MX25V8006E | MX25V8035F | NX25P80 | PM25LV080 | PM25LV080B | S25FLO08A | S25FLO08K |
S25FL208K | SST25VF080B | SST25WF080 | SST25WF080B | TS25L80P | W25D80V | W25P80V | W25Q40CL | W25Q80BL | W25Q80BV | W25Q80BW | W25Q80DL |
W25Q80DV | W25Q80EW | W25Q80FV | W25Q801V | W25X80AL | W25X80AV | W25X80BV | W25X80L | W25X80V | XM25QH80B | XM25QU80B

25PExx
(8Mb)

AT25PE80 | AT25PE80[P264]

A25L016 | A25L16P | A25LQ16 | AT25DF161 | AT25DL161 | AT25FF161A | AT25SF161 | AT26DF161 | EN25B16 | EN25D16 | EN25F16 | EN25P16 | EN25Q16A | EN25QA16 |
EN25QH16 | EN25S16 | EN25T16 | ES25M16 | ES25P16 | F16 | F25L016 | F25L16P | F25L16PA | F25L16Q | F25L16QA | FM25Q16 | FM25Q16A | FM25Q16B | FM25S16A |
GD25LQ16 | GD25Q16B | IS25LP016D | IS25LQ016B | IS25WP016 | IS25WP016D | KH25L1605A | KH25L1605D | KH25L1606E | KH25L1635D | LE25S161 | M25P16 |
25..016 M25PE16 | M25PX16 | M25X16 | MS25X16 | MX25L1605 | MX25L1605A | MX25L1605D | MX25L1606E | MX25L1608D | MX25L1608E | MX25L1633E | MX25L1635D |
(16Mb) MX25L1635E | MX25L1636D | MX25L1636E | MX25L1673E | MX25L1675E | MX25R1635F | MX25U1633F | MX25U1635E | MX25U1635F | MX25V1635F | N25Q016 | NX25P16
| PM25LV016 | PM25LV016B | Q16 | QB25F016S33B | QH25F016S33B | S25FL016 | S25FLO16A | S25FLO16K | S25FL116K | S25FL216K | SA25F160 | SST25VFO16B |
TS25L16AP | TS25L16BP | TS25L16P | W25Q16BF | W25Q16BV | W25Q16CL | W25Q16CV | W25Q16DV | W25Q16DW | W25Q16FW | W25Q16]L | W25Q161V | W25Q16VF |
W25X16AL | W25X16AV | W25X16BV | W25X16V | XM25QH16B | XM25QU16B

25PExx
(16Mb)

AT25PE16 | AT25PE16[P528]

A25L032 | A25LQ32A | AT25DF321 | AT25DF321A | AT25FF321A | AT25QL321 | AT25SF321 | AT25SL321 | AT26DF321 | AT26SD321 | EN25B32 | EN25F32 | EN25P32 |
EN25Q32B | EN25QA32 | EN25QH32 | EN25S32 | ES25P32 | F25L32P | F25L32PA | F25L32Q | F25L32QA | F32 | FM25Q32 | FM25Q32A | GD25B32C | GD25LB32D |
GD25LQ32 | GD25LQ32C | GD25Q32B | GD25Q32C | IS25CQ032 | IS25CQ032A | IS25LP032D | 1S25LQ032B | IS25WP032 | IS25WP032D | KH25L3205D | KH25L3206E |
25..032 M25P32 | M25PE32 | M25PX32 | M25X32 | MX25L3205A | MX25L3205D | MX25L3206 | MX25L3206E | MX25L3208D | MX25L3208E | MX25L3225D | MX25L3233F |
(32Mb) MX25L3235D | MX25L3235E | MX25L3236D | MX25L3236E | MX25L3236F | MX25L3237D | MX25L3239E | MX25L3255E | MX25L3273E | MX25L3273F | MX25L3275E |
MX25R3235F | MX25U3235E | MX25U3235F | MX25U3273F | N25Q032 | NX25P32 | Q32 | QB25F320S33B | QH25F320S33B | S25FL032 | S25FL032A | S25FL032K |
S25FL032P | S25FL132K | SA25F320 | SST25VF032B | W25Q32BV | W25Q32DW | W25Q32FV | W25Q32FW | W25Q32IV | W25Q32IW | W25Q32V | W25Q32VF | W25X32AV
| W25X32BV | W25X32V | XM25QH32B | XM25QU32B | XM25QW32C
A25LMQ64 | A25LQ64 | AT25DF641A | AT25QF641 | AT25QL641 | AT25SF641 | AT25SL641 | EN25F64 | EN25Q64 | EN25QA64 | EN25QH64 | EN25S64 | F25D64QA |
F25L64QA | F64 | FM25Q64 | FM25Q64A | GD25B64 | GD25B64C | GD25LB64C | GD25LQ64B | GD25LQ64C | GD25Q64B | GD25Q64C | IS25LP064 | IS25LP064A |
IS25WP064 | IS25WP064A | KH25L6405D | KH25L6406E | M25P64 | M25PX64 | MT25QLO64A | MT25QUO64A | MX25L64 | MX25L6405 | MX25L6405D | MX25L6406E |
25..064 MX25L6408 | MX25L6408D | MX25L6408E | MX25L6433 | MX25L6433F | MX25L6435 | MX25L6435E | MX25L6436E | MX25L6436F | MX25L6439 | MX25L6439E |
(64Mb) MX25L6445E | MX25L6455E | MX25L6456 | MX25L6456E | MX25L6456F | MX25L6465E | MX25L6473E | MX25L6473F | MX25L6475E | MX25R6435F | MX25U6435 |
MX25U6435E | MX25U6435F | MX25U6473 | MX25U6473F | N25Q064 | N25Q064A11 | N25Q064A13 | Q64 | QB25F640S33B | QH25F640S33B | S25FLO64A | S25FL064K |
S25FLO64L | S25FL064P | S25FL164K | S25FS064S | S64 | SST25VF064C | W25Q64BV | W25Q64CV | W25Q64DW | W25Q64FV | W25Q64FW | W25Q643V | W25Q64IW |
W25Q64VF | W25X64BV | W25X64V | XM25QH64A | XM25QUE4A | XM25QW64C
25..128 AT25QL128A | AT25SL128A | EN25Q128 | EN25QA128 | EN25QH128 | EN25QH128A | F25D128QA | F25L128QA | GD25B127D | GD25B128 | GD25LB128D | GD25LQ128 |
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(128Mb)

ATXPxx
(32-128Mb)

25..256
(256Mb)

25..512
(512Mb)
25..01
(1Gb)
25..02
(2Gb)

25..05
(512kb)

25..010
(1Mb)

25..020
(2Mb)

GD25LQ128C | GD25LQ128D | GD25Q127 | GD25Q128B | GD25Q128C | IS25LP128 | IS25LP128F | IS25WP128 | IS25WP128F | KH25L12845E | M25P128 | MT25QL128A |
MT25QU128A | MX25L128 | MX25L12805D | MX25L12835E | MX25L12835F | MX25L12836E | MX25L12839F | MX25L12845E | MX25L12845G | MX25L12850F | MX25L12855E
| MX25L12855F | MX25L12865E | MX25L12865F | MX25L12873F | MX25L12873G | MX25L12875F | MX25LM12845G | MX25U128 | MX25U12835F | MX25U12873F |
MX25U12890F | MX25UM12845G | N25Q128 | N25Q128A11 | N25Q128A13 | Q128 | S25FL127S | S25FL128K | S25FL128L | S25FL128P | S25FL128S | S25FL129P |
S25FS128S | W25Q128BV | W25Q128FV | W25Q128FW | W25Q1281V | W25Q128IW | XM25QH128A | XM25QU128C | XM25QW128C

ATXP32, ATXP64, ATXP128

EN25QA256 | EN25QH256 | EN25QH256A | EN25S256 | GD25B256D | GD25B257D | GD25LB256D | GD25LQ256 | GD25LQ256C | GD25LQ256D | GD25Q256 | GD25Q257D |
IS25LP256D | IS25LP256E | IS25WP256D | MT25QL256A | MT25QU256A | MX25L25635E | MX25L25635F | MX25L25639F | MX25L25645G | MX25L25655E | MX25L25655F |
MX25L25673G | MX25L25735E | MX25L25735F | MX25L25835E | MX25L25855E | MX25LM25645G | MX25U25635F | MX25U25645G | MX25UM25645G | N25Q256A11 |
N25Q256A13 | N25Q256A33 | N25Q256A73 | N25Q256A81 | N25Q256A83 | S25FL256L | S25FL256P | S25FL256S | S25FS256S | W25Q256FV | W25Q2561V | W25Q256IW |
W25Q257FV | W25Q257IV | XM25QH256B | XM25QU256B | XM25QW256C
GD25Q512 | IS25LE512M | IS25LP512M | IS25WP512M | MT25QL512A | MT25QU512A | MX25L51237G | MX25L51245G | MX25L51255G | MX25LM51245G | MX25U51245G |
MX25UM51245G | MX66L51235F | MX66U51235F | S25FL512S | S25FS512S | W25Q5121V

MT25QLO1G | MT25QU01G | W25Q013V
MT25QL02G | MT25QU02G

A25LO5P | A25L512 | A25L512A | A25LS512A | AC25LV512 | AT25DL5121 | AT25DN512C | AT25F512 | AT26DF5121 | EN25B05 | EN25F05 | EN25P05 | F25D512Q |
F25L0512 | F25L05P | F25L05PA | F25L512P | F25L512Q | GD25D05C | GD25Q05 | GD25WD05C | KH25L512 | M25P05 | M25P05-A | MS25X512 | MX25L512 | MX25L5121 |
MX25L5121E | MX25L512C | MX25L512E | MX25R512F | MX25U5121E | MX25V512 | MX25V5121E | MX25V512C | MX25V512E | MX25V512F | PM25LD512 | PM25LV512 |
PM25LV512A | SA25F005 | SST25VF512 | SST25VF512A | SST25WF512 | SST25WF512B | W25Q05CL | W25Q05CV | W25X05CL

A25L010 | A25L010A | A25L10P | AC25LV010 | AT24F1024 | AT25DNO11 | AT25FS010 | EN24LF10 | EN25B10 | EN25F10 | EN25LF10 | EN25P10 | EN25S10 | ES25P10 |
F25L01P | F25L01PA | GD25D10C | GD25Q10 | GD25WD10C | IS25CD010 | IS25LQ010B | KH25L1005 | LE25FU106 | LE25FU106B | M25P10 | M25P10-A | M25PE10 |
MS25X10 | MX25L1005 | MX25L1005C | MX25L1005ZM | MX25L1006 | MX25L1006E | MX25L1021 | MX25L1021E | MX25L1025 | MX25L1025C | MX25L1026 | MX25L1026E |
MX25R1035F | MX25U1001E | MX25V1006 | MX25V1006E | MX25V1035F | NX25P10 | PM25LD010 | PM25LV010 | PM25LVO10A | S25FL001D | SA25F010 | SST25VF010 |
SST25VF010A | SST25WF010 | TS25L010A | W25D10V | W25P10V | W25Q10BV | W25Q10CL | W25Q10CV | W25Q10EW | W25X10AV | W25X10BL | W25X10BV | W25X10CL
| W25X10L | W25X10V

A25L020 | A25L020C | A25L20P | AT25DF021 | AT25F2048 | AT25F2048N | EN25B20 | EN25F20 | EN25LF20 | EN25P20 | EN25520 | ES25P20 | F25D02P | F25D02QA |
F25L02P | F25L02PA | GD25D20C | GD25Q20B | GD25Q21B | GD25WD20C | IS25LQ020 | IS25WD020 | IS25WP020D | IS25WQ020 | KH25L2005 | LE25FU206 | LE25S20 |
LE25U20 | M25P20 | M25PE20 | M25U2033E | MS25X20 | MX25L2005 | MX25L2005C | MX25L2005ZM | MX25L2006 | MX25L2025C | MX25L2026E | MX25L26C |
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25PExx
(2Mb)

25..040
(4Mb)

25PExx
(4Mb)

25..080
(8Mb)

25PExx
(8Mb)

25..016
(16Mb)

MX25R2035F | MX25U2032E | MX25U2033E | MX25U2035F | MX25V2006E | MX25V2033F | MX25V2035F | NX25P20 | PM25LD020 | PM25LV020 | S25FL002D | SA25F020 |
SST25VF020 | SST25VF020A | SST25VF020B | SST25WF020 | SST25WF020B | TS25L020A | W25D20V | W25P20V | W25Q20BW | W25Q20CL | W25Q20CV | W25Q20EW |
W25X20BL | W25X20BV | W25X20CL | XM25QU20B

AT25PE20 | AT25PE20[P264]

A25L040 | A25L040A | A25L40P | AT25DF041 | AT25DF041A | AT25F4096 | AT25FS040 | AT25SF041 | AT26F004 | EN25B40 | EN25F40 | EN25LF40 | EN25P40 | EN25Q40 |
EN25S40 | EN25T40 | ES25M40 | ES25P40 | F25D04Q | F25D04QA | F25L004 | F25L04P | F25L04PA | GD25D40C | GD25LQ40 | GD25Q40B | GD25Q41B | GD25WD40C |
I1S25LD040 | IS25LQ040B | IS25WD040 | IS25WP040 | IS25WP040D | IS25WQ040 | KH25L4005A | KH25L4006E | LE25FS406 | LE25FU406B | LE25S40 | LE25U40 | M25P40
| M25PE40 | MS25X40 | MX25L4005 | MX25L4005A | MX25L4005C | MX25L4006E | MX25L4025C | MX25L4026E | MX25R4035F | MX25U4032F | MX25U4033E | MX25U4035
| MX25U4035F | MX25V4005 | MX25V4005C | MX25V4006E | MX25V4035 | NX25P40 | PM25LD040 | PM25LV040 | S25FL004 | S25FLO04A | S25FL004K | S25FL204K |
SA25F040 | SST25VF040 | SST25VF040A | SST25VF040B | SST25WF040 | SST25WF040B | W25D40V | W25P40V | W25Q40BL | W25Q40BV | W25Q40BW | W25Q40CL |
W25Q40EW | W25X40AL | W25X40AV | W25X40BL | W25X40BV | W25X40CL | W25X40L | W25X40V | XM25QH40B | XM25QU40B

AT25PE40 | AT25PE40[P264]

A25L080 | A25L80P | AT25DF081 | AT25DF081A | AT25DL081 | AT25SF081 | AT26DF081 | EN25B80 | EN25D80 | EN25F80 | EN25P80 | EN25Q80 | EN25Q80A | EN25S80 |
EN25T80 | ES25M80 | ES25P80 | F25D08QA | F25L08QA | FM25Q08 | FM25Q08A | GD25D80C | GD25LQ80 | GD25Q80B | GD25Q80C | GD25WD8OC | IS25LP08OD |
1S25LQ080 | IS25LQ080B | IS25WP080 | IS25WP080D | KH25L8005 | KH25L8006E | KH25L8036D | LE25S81 | M25P80 | M25PESO | M25PX80 | M25X80 | MS25X80 |
MX25L8005 | MX25L8005ZM | MX25L8006E | MX25L8008E | MX25L8035E | MX25L8036E | MX25L8073E | MX25L8075E | MX25R8035F | MX25U8032E | MX25U8033E |

MX25U8035 | MX25U8035E | MX25U8035F | MX25V8005 | MX25V8006E | MX25V8035F | NX25P80 | PM25LV080 | PM25LV080B | S25FLO08A | S25FLO08SK | S25FL208K |
SST25VF080B | SST25WF080 | SST25WF080B | TS25L80P | W25D80V | W25P80V | W25Q40CL | W25Q80BL | W25Q80BV | W25Q80BW | W25Q80DL | W25Q80DV |
W25Q80EW | W25Q80FV | W25Q801V | W25X80AL | W25X80AV | W25X80BV | W25X80L | W25X80V | XM25QH80B | XM25QUS0B

AT25PE80 | AT25PE8B0[P264]

A25L016 | A25L16P | A25LQ16 | AT25DF161 | AT25DL161 | AT25SF161 | AT26DF161 | EN25B16 | EN25D16 | EN25F16 | EN25P16 | EN25Q16A | EN25QA16 | EN25QH16 |
EN25S16 | EN25T16 | ES25M16 | ES25P16 | F16 | F25L016 | F25L16P | F25L16PA | F25L16Q | F25L16QA | FM25Q16 | FM25Q16A | FM25Q16B | FM25S16A | GD25LQ16 |
GD25Q16B | IS25LP016D | IS25LQ016B | IS25WP016 | IS25WP016D | KH25L1605A | KH25L1605D | KH25L1606E | KH25L1635D | LE25S161 | M25P16 | M25PE16 |
M25PX16 | M25X16 | MS25X16 | MX25L1605 | MX25L1605A | MX25L1605D | MX25L1606E | MX25L1608D | MX25L1608E | MX25L1633E | MX25L1635D | MX25L1635E |
MX25L1636D | MX25L1636E | MX25L1673E | MX25L1675E | MX25R1635F | MX25U1633F | MX25U1635E | MX25U1635F | MX25V1635F | N25Q016 | NX25P16 | PM25LVO16 |
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25PExx
(16Mb)

25..032
(32Mb)

25..064
(64Mb)

25..128
(128Mb)

25..256
(256Mb)

PM25LV016B | Q16 | QB25F016S33B | QH25F016S33B | S25FL016 | S25FLO16A | S25FLO16K | S25FL116K | S25FL216K | SA25F160 | SST25VFO16B | TS25L16AP |
TS25L16BP | TS25L16P | W25Q16BF | W25Q16BV | W25Q16CL | W25Q16CV | W25Q16DV | W25Q16DW | W25Q16FW | W25Q16IL | W25Q16IV | W25Q16VF | W25X16AL |
W25X16AV | W25X16BV | W25X16V | XM25QH16B | XM25QU16B

AT25PE16 | AT25PE16[P528]

A25L032 | A25LQ32A | AT25DF321 | AT25DF321A | AT25QL321 | AT25SF321 | AT25SL321 | AT26DF321 | AT26SD321 | ATXP32 | EN25B32 | EN25F32 | EN25P32 |
EN25Q32B | EN25QA32 | EN25QH32 | EN25S32 | ES25P32 | F25L32P | F25L32PA | F25L32Q | F25L32QA | F32 | FM25Q32 | FM25Q32A | GD25B32C | GD25LB32D |
GD25LQ32 | GD25LQ32C | GD25Q32B | GD25Q32C | IS25CQ032 | IS25CQ032A | IS25LP032D | IS25LQ032B | IS25WP032 | IS25WP032D | KH25L3205D | KH25L3206E |
M25P32 | M25PE32 | M25PX32 | M25X32 | MX25L3205A | MX25L3205D | MX25L3206 | MX25L3206E | MX25L3208D | MX25L3208E | MX25L3225D | MX25L3233F |
MX25L3235D | MX25L3235E | MX25L3236D | MX25L3236E | MX25L3236F | MX25L3237D | MX25L3239E | MX25L3255E | MX25L3273E | MX25L3273F | MX25L3275E |
MX25R3235F | MX25U3235E | MX25U3235F | MX25U3273F | N25Q032 | NX25P32 | Q32 | QB25F320S33B | QH25F320S33B | S25FL032 | S25FL032A | S25FL032K |
S25FL032P | S25FL132K | SA25F320 | SST25VF032B | W25Q32BV | W25Q32DW | W25Q32FV | W25Q32FW | W25Q32IV | W25Q32IW | W25Q32V | W25Q32VF | W25X32AV
| W25X32BV | W25X32V | XM25QH32B | XM25QU32B | XM25QW32C

A25LMQ64 | A25LQ64 | AT25DF641A | AT25QF641 | AT25QL641 | AT25SF641 | AT25SL641 | ATXP64 | EN25F64 | EN25Q64 | EN25QA64 | EN25QH64 | EN25S64 |
F25D64QA | F25L64QA | F64 | FM25Q64 | FM25Q64A | GD25B64 | GD25B64C | GD25LB64C | GD25LQ64B | GD25LQ64C | GD25Q64B | GD25Q64C | IS25LP064 |
IS25LP064A | IS25WP064 | IS25WP064A | KH25L6405D | KH25L6406E | M25P64 | M25PX64 | MT25QLO64A | MT25QUO64A | MX25L64 | MX25L6405 | MX25L6405D |
MX25L6406E | MX25L6408 | MX25L6408D | MX25L6408E | MX25L6433 | MX25L6433F | MX25L6435 | MX25L6435E | MX25L6436E | MX25L6436F | MX25L6439 |
MX25L6439E | MX25L6445E | MX25L6455E | MX25L6456 | MX25L6456E | MX25L6456F | MX25L6465E | MX25L6473E | MX25L6473F | MX25L6475E | MX25R6435F |
MX25U6435 | MX25U6435E | MX25U6435F | MX25U6473 | MX25U6473F | N25Q064 | N25Q064A11 | N25Q064A13 | Q64 | QB25F640S33B | QH25F640S33B | S25FLO64A |
S25FL064K | S25FLO64L | S25FL064P | S25FL164K | S25FS064S | S64 | SST25VF064C | W25Q64BV | W25Q64CV | W25Q64DW | W25Q64FV | W25Q64FW | W25Q641V |
W25Q64IW | W25Q64VF | W25X64BV | W25X64V | XM25QH64A | XM25QU6E4A | XM25QW64C

AT25QL128A | AT25SL128A | ATXP128 | EN25Q128 | EN25QA128 | EN25QH128 | EN25QH128A | F25D128QA | F25L128QA | GD25B127D | GD25B128 | GD25LB128D |
GD25LQ128 | GD25LQ128C | GD25LQ128D | GD25Q127 | GD25Q128B | GD25Q128C | IS25LP128 | IS25LP128F | IS25WP128 | IS25WP128F | KH25L12845E | M25P128 |
MT25QL128A | MT25QU128A | MX25L128 | MX25L12805D | MX25L12835E | MX25L12835F | MX25L12836E | MX25L12839F | MX25L12845E | MX25L12845G | MX25L12850F
| MX25L12855E | MX25L12855F | MX25L12865E | MX25L12865F | MX25L12873F | MX25L12873G | MX25L12875F | MX25LM12845G | MX25U128 | MX25U12835F |
MX25U12873F | MX25U12890F | MX25UM12845G | N25Q128 | N25Q128A11 | N25Q128A13 | Q128 | S25FL127S | S25FL128K | S25FL128L | S25FL128P | S25FL128S |
S25FL129P | S25FS128S | W25Q128BV | W25Q128FV | W25Q128FW | W25Q128IV | W25Q128IW | XM25QH128A | XM25QU128C | XM25QW128C

EN25QA256 | EN25QH256 | EN25QH256A | EN25S256 | GD25B256D | GD25B257D | GD25LB256D | GD25LQ256 | GD25LQ256C | GD25LQ256D | GD25Q256 | GD25Q257D |
IS25LP256D | IS25WP256D | MT25QL256A | MT25QU256A | MX25L25635E | MX25L25635F | MX25L25639F | MX25L25645G | MX25L25655E | MX25L25655F | MX25L25673G
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| MX25L25735E | MX25L25735F | MX25L25835E | MX25L25855E | MX25LM25645G | MX25U25635F | MX25U25645G | MX25UM25645G | N25Q256A11 | N25Q256A13 |
N25Q256A33 | N25Q256A73 | N25Q256A81 | N25Q256A83 | S25FL256L | S25FL256P | S25FL256S | S25FS256S | W25Q256FV | W25Q256IV | W25Q256IW | W25Q257FV |
W25Q2573V | XM25QH256B | XM25QU256B | XM25QW256C

25..512 GD25Q512 | IS25LP512M | IS25WP512M | MT25QL512A | MT25QU512A | MX25L51237G | MX25L51245G | MX25L51255G | MX25LM51245G | MX25U51245G |
(512Mb) MX25UM51245G | MX66L51235F | MX66U51235F | S25FL512S | S25FS512S | W25Q5121V

25..01

MT25QLO1G | MT25QU01G | W25Q01IV
(1Gb)
25..02
MT25QL02G | MT25QU02G
(2Gb)

9.9. FLASH SPI 26... series

Supports low-voltage serial flash memories (1.8V) and standard (3.3V)

26.. SST26WF040B | SST26WF040BA | SST26WF080B | SST26WFO80BA | SST26VF016 | SST26VF016B | SST26WF016B | SST26WF016BA | SST26VF032 | SST26VF032B
(4 - 64MBiIt) | SST26VF032BA | SST26VF064B | SST26VFO064BA | SST26VF064C | SST26VF064CA | SST26WF064C | SST26WF064CA

9.10. FLASH SPI 45... series (DATA FLASH)

Atmel / Adesto: AT45DB021 | AT45DB021D | AT45DB021E | AT45DB041 | AT45DB041D | AT45DB041E | AT45DB081 | AT45DB081D | AT45DBO81E | AT45DB161 |

45.. AT45DB161D | AT45DB161E | AT45DQ161 | ATA5DB321 | ATA5DB321D | ATA5DB321E | AT45DQ321 | ATA5DB642 | ATA5DB642D | ATA5DB641E
(1 - 64MBiIt) Micron: M45PE10 | M45PE20 | M45PE40 | M45PE8O | M45PE16
S
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9.11. FLASH SPI NAND

GD5F1GQ4RB | GD5F1GQ4RC | GD5F1GQ4RE | GD5F1GQ4RF | GD5F1GQ4UB | GD5F1GQ4UC | GDS5F1GQ4AUE | GD5F1GQAUF | IS37SMLO1G1 | IS38SMLO1G1 | MT29F1GO1AAADD |

1Gb
MT29F1GO1ABAFD | MT29F1GO1ABAGD | MT29F1GO1ABBFD | MT29F1GO1ABBGD | TC58CVGOS3HRA | TC58CYGOS3HRA | W25N01GV | W25N01GW | W25N01IW
2Gb GD5F2GQ4RB | GD5F2GQ4RC | GD5F2GQ4RE | GD5F2GQ4RF | GD5F2GQ4UB | GD5F2GQ4UC | GD5F2GQ4UE | GD5F2GQ4UF | MT29F2G01AAAED | MT29F2G01ABAGD |
MT29F2G01ABBGD | TC58CVG1S3HRA | TC58CYG1S3HRA | W25N02JW | W25N02KV
4Gb MT29F4G01ABAFD | MT29F4GO1ABBFD | MT29F4GO1ADAGD | TC58CVG2SOHRA | TC58CYG2S0HRA

9.12. FRAM I2C 24... series

24..04
(akb) FM24C04 | FM24C04B | FM24CLO04 | FM24CL04B | MB85RC04V

24..16

(16kb) FM24C16 | FM24C16B | FM24CL16 | FM24CL16B | FM25C160B | MB85RC16 | MB8SRC16V
24..64

(64kb) FM24C64 | FM24C64B | FM24CL64 | FM24CL64B | MB85RC64 | MB85SRC64A | MR44V064B
24..01

FM24V01 | MB85RC128 | MB85RC128A
(128kb)
24..02
FM24V02 | FM24V02A | FM24W256 | MB85RC256V
(256kb)
24..05
FM24V05
(512kb)
24..10
FM24V10 | FM24VN10 | MR44V100A
(1Mb)
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9.13. FRAM SPI 25...

25..040
(4kb)

25..160
(16kb)

25..320
(32kb)

25..640
(64kb)

25..01
(128kb)

25..02
(256kb)

25..05
(512kb)

25..10
(1Mb)

25..20
(2Mb)

25..40
(4Mb)

25..80
(8Mb)

series

FM25040 | FM25040B | FM2504B | FM25CL04B | FM25L04 | FM25L04B

FM25C160 | FM25C160B | FM25L16 | FM25L16B

MR45V032A

FM25640 | FM25640B | FM25CL64 | FM25CL64B | MB85RS64 | MB85RS64A | MR45V064B

FM25Vv01 | FM25V01A | MB85RS128A | MB85RS128B

FM25V02 | FM25V02A | FM25W256 | MB85RS256A | MB85RS256B | MR45V256A

FM25V05

FM25V10 | FM25VN10 | MR45V100

CY15B102Q | CY15V102Q | FM25H20 | FM25V20 | FM25V20A | MR45V200

CY15B104Q | CY15V104Q

CY15B108Q | CY15V108Q
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9.14. Optical and ethernet modules (SFP/SFP+ transceivers)

Please note!

» there is SFP/QSFP/XFP adapter required with external power supply,

e« MSA standard is supported (e.g. SFF-8472, SFF-8636, INF-8077i),

e possibility to enter manufacturer/host password and program write protected transceivers,

e brute force password tool (searching password for protected transceivers with unknown password),

« change manufacturer info, model, serial number etc. and recalculate checksums directly from REVELPROG-IS application

SFP and SFP+, read/write block 0xAO0 (256B), read block 0xA2 (256B), read/write page 0-255 (128B), standard MSA
example manufacturers: GBC, HUAWEI, GPON, JDSU, MIKROTIK, OPTEC, OPTION, WTD and other OEM

SFP / SFP+

QSFP and QSFP+, read/write AOh block (256B), read/write 0-255 page (128B), standard MSA
example manufacturers: CISCO, HP, FINISAR, NOKIA, HUAWEI, JDSU and other OEM

QSFP / QSFP+

XFP, read/write AOh block (256B), read/write 0-255 table (128B), standard MSA
example manufacturers: 10GTEK, CISCO, FINISAR, OPNEXT, JDSU and other OEM

XFP

9.15. Your suggestions

If you have any suggestion for supported device list please contact us at lab@reveltronics.com. There is possibility to add any serial device
with I2C, SPI or uWire interface (EEPROM/FLASH/FRAM).
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11. APPENDIX B - video tutorials and technical support

Programming examples on youtube:

https://www.youtube.com/playlist?list=PLKdrjJPMLd8KBX12vHdyCg 0JfNTOAw7U

REVELTRONICS' forum:

https://forum.reveltronics.com/viewforum.php?f=17

- 54 -



